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Preface

Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology
Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-085940.html|
contains the latest versions of the Agile PLM PDF files. You can view or download these manuals
from the Web site, or you can ask your Agile administrator if there is an Agile PLM Documentation
folder available on your network from which you can access the Agile PLM documentation (PDF)
files.

Note To read the PDF files, you must use the free Adobe Acrobat Reader version 9.0 or later.
This program can be downloaded from the Adobe Web site http://www.adobe.com.

The Oracle Technology Network (OTN) Web site
http://www.oracle.com/technetwork/documentation/agile-085940.html can be accessed through Help
> Manuals in both Agile Web Client and Agile Java Client. If you need additional assistance or
information, please contact My Oracle Support (https://support.oracle.com) for assistance.

Note Before calling Oracle Support about a problem with an Agile PLM manual, please have
the full part number, which is located on the title page.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398.
Outside the United States, call +1.407.458.2479.

Readme

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle
Technology Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-
085940.html.

Agile Training Aids

Go to the Oracle University Web page
http://www.oracle.com/education/chooser/selectcountry _new.html for more information on Agile
Training offerings.
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Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise empty line;
however, some screen readers may not always read a line of text that consists solely of a bracket or
brace.

This documentation may contain links to Web sites of other companies or organizations that Oracle
does not own or control. Oracle neither evaluates nor makes any representations regarding the
accessibility of these Web sites.
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Chapter 1
Cetting Started in CNM

This chapter includes the following:

= Welcome to Customer Needs ManagemeNnt............cccueueiieiiicriiniiesice e 1
S I o o 1Yo I T (o T O PP ERT PP 1

Welcome to Qustomer Needs Management

Welcome to Agile Customer Needs Management Guide. Customer Needs Management (CNM) is a
product that helps you transform market requirements into products. Those requirements can come
in from a number of sources such as CRM, Quality or other enterprise applications or detailed
documents received from customers, and so on. CNM offers a platform on which Product and
Project owners can capture, filter, refine, collaborate on, prioritize and eventually incorporate those
requirements into products.

How to FHnd Documentation for ONM

The Oracle Agile documentation set is found at this Web site:
http://www.oracle.com/technetwork/documentation/agile-085940.html.

Installation Test Notice

Install and test this release on a designated development server before installing it on your
production environment. Your development environment should mirror your production environment
as closely as possible to provide accurate testing results. It is important to validate the installation of
this release, and confirm your integrations are working correctly as part of your minimum due
diligence. Any problems or questions noted during your development system testing should be
resolved before installing this release on your production environment.

Logging in to C\NM

Prior to logging in to CNM your user account needs to be created and enabled in Oracle's Agile
product lifecycle management application or in LDAP. For more information, see the CNM
Implementation Guide.
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First, be sure to disable the popup blocker for CNM related URLs in the browser you are using.
Enter the determined URL for the CNM application. The login page appears as below:

ORACLE" Agile Customer Needs Management

Login
Enter your username and password.
Username:

Password:

Enter your username and password and then click @. You are brought to the Home Page of the
CNM application.
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Chapter 2

Exploring the Home Page

This chapter includes the following:

B OVEIVIBW ..ttt et 3
B MY PENAING REVIEWS ...ttt sttt bbbttt s s 5
B RECENTUPAALES ...ttt st ettt nn s 5
B RECOMS BY SEALUS ... 7
B TAG ClOUD ..o 7
B CTBALE 1ttt bbbt 8
B SearChING iN CNM ... bbbt 10
B USEI PIEIEIEINCES .. ..cvuviiiiei ettt bbb 15
L o 1Y o TP PP 15
L I o TR T TP 16
Overview

Once you successfully log in to CNM you are brought to the Home Page, where you can:
o View the outstanding reviews requested from you in the My Pending Reviews area
o Read the latest information about objects in the Recent Updates area

o Review a graphical representation of the current status of objects from the Records By Status
dashboard area

o View the tags, or categories, given to objects to locate a grouping of specific objects from the
Tag Cloud

o Create objects using the Create button

o Access bookmarked objects using the Favorites menu

o Go to recently visited objects using the Recents menu

@ Access the Tools menu

@ Search for an individual object in CNM using Search

o Access to system configuration using the Administration link
o Change your display using the User Preferences link

@ Access clarification about CNM behavior from the Help link

o End your current user session from the Logout link

v1.1 3
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When you log into CNM you are immediately brought to the Home page where there is a tab for
Home and Browse. Both of these tabs cannot be closed. They are static tabs that are always
available to access at any time.

The Browse tab gives you access to a search page where you can perform a Quick search or an
Advanced search. Executing any search opens up search results in the Browse tab. If the Browse tab
already contains executed search results, the Browse tab is reused and the older search results are
replaced by the newer ones.

ORACLE Agile Customer Needs Management

Home B

Recent Updates [l Records By Status

s By Type I ldea - I

Q IDEADODZS: beers (Last Modified today)
* Modified by Azita Kamangar yesterday : Tags was

Q IDEADOS03: new object 1030 (Last Medified today)
* Modified by Azita Kamangar today : Detailz content updated;
* Modified by Azita Kamangar vesterday : Tags was =null= iz <test=;

Q IDEADODZ24: drinks (Last Modified today)
* Modified by Azita Kamangar today : Detailz content updated;
e W Approved Af W A Approved W Fer
Q IDEADZ333: Chinese characters 2/1/11 (Last Modified yesterday) Ml Rejected I In Frogress Hint
+ Medified by Jody Wu vesterday : Description was <null= is <test>; I Review Ml Canceled M ~pr

| =500 ..
* Created by Jody Wu yesterday N progress n

Q" DEAD2332: 22 (Last Modified yesterday) =l Tags

Multiple tabs can be seen as objects and areas of CNM are opened. As users open an object or
area of CNM, that becomes the latest tab found at the end of the row of tabs. The maximum
number of tabs is ten. Once a user reaches that limit they are notified that a tab needs to be closed
in order to proceed with opening another tab to once again be at the maximum of ten open tabs. If a
user selects an area of CNM or an object that is already an active and open tab, the page focus for
the user is changed to the already available tab.

The following sections illustrate how to navigate through each component accessible from the Home
page.
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My Pending Reviews

When you are assigned as a reviewer for any number of objects, they display as a list in reverse
chronological order in the My Pending Reviews section.

My Pending Reviews

|£] REQO0014: Improve battery life

by Admin CHM on 02/08/2011 05:01.24

\/ POO0OTE: New Camera Concepts

Uor sl

o POOOTT: Camera - Baseline 1

Uor sl

The object IDs are active links that direct you back to the object so you can carry out your review for
that specific object. If the user has no current assignments then this section does not display for the
user.

For more information about review assignments, see Object Signoffs on page 38.

Recent Updates

The Recent Updates area displays a list of summaries about what has happened to certain objects
since you logged out of the system. If you last logged out of CNM more than thirty days prior to your
current login session you see only updates from as far back as thirty days. A maximum of five
updates are displayed for each object. CNM finds a minimum of ten object updates to display and a
maximum of twenty.
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The Recent Updates area is seen below:

Recent Updates

“.# QUOTECD11&: Sperts Arena (Last modified today)
* Component removed by Mariah Thomas today: Remowe Component: Food
* Component added by Mariah Thomas today: Add Component: Food
* Component added by Mariah Thomas today: Add Component: Retail
* Component added by Mariah Thomas today: Add Component: Sports
* Medified by Mariah Thomas today: Tags was <= iz <ideamt=

Q IDEAQD347: Soccer (Last modified today)
* Created by Mariah Thomas today

'Q IDEAOD0235: Bageball (Last modified today)
* Modified by Mariah Thomas today: Tags was <> is <ideaMT=
* Created by Mariah Thomas today

Q IDEAO0334: Basketball (Last modified today)
* Modified by Mariah Thomas today: Tags was <> iz <idealT=
* Created by Mariah Thomas today

Q IDEAO0335: Football (Last modified today)
* Medified by Mariah Thomas today: Tags was <= iz <ideamt=
* Created by Mariah Thomas today

'Q IDEAOD23T: Volleyball (Last modified today)
* Maodified by Mariah Thomas today: Tags was <= iz <ideamt=
* Created by Mariah Thomas today

RECQ01312: Sports (Last modified today)
* Maodified by Mariah Thomas today: Tags was <= ig <reqmt>
* Component added by Mariah Thomas today: Add Component: Soccer
* Component added by Mariah Thomas today: Add Component: Hockey
*  Component added by Mariah Thomas today: Add Component: Basketball
* Component added by Mariah Thomas today: Add Component: Football

Object information is displayed when you are the creator of an object and still a team member, or if
you are simply a team member of the object. The summary records follow a reverse chronological
formatting with the last update of the objects at the top. Each heading with the object name
displayed in the Recent Updates area is an active link that takes you directly to that object.

6 Agile Product Lifecycle Management
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Records By Status

The Records By Status area has a graphical display, or dashboard, of CNM objects filtered by type,
and sorted by their current status, as seen in the figure below:

[=] Records By Status

W Approved Il Pending M Rejected Il Review

This dashboard gives you an at-a-glance report of how objects are progressing in CNM. You can
then click any region of the dashboard graphic and automatically run a search for all the objects of
the selected type that are currently in that state. These search results display in the Browse tab.
Once the search results display the corresponding objects that match the status search criteria, you
can select an object in the results and go directly to its Summary section.

The search executed by clicking the dashboard has the same limitations as any other search in
CNM. If you do not have access to all the objects that fall within the category you selected, then you
are only shown the objects that match your search criteria that you also have access to in the
Search Results table. For more information about searches, see Searching in CNM on page 10.

Tag Aoud

Tags are a utility that provide a way to categorize and group objects. All users with a Participant role
or higher can add or remove tags. Multiple tags can be associated with one object as long as the
individual tags are separated by a comma. All tags are shown in alphabetical order, are displayed in
lowercase and if entered in uppercase will by default display in lowercase. When tags are
associated with objects, CNM tracks these tags and makes them available as auto-generated
suggestions for users to include as a tag in order to eliminate repeated tags.

To add a tag to an object:

4

1. From the Summary section of the object click .

2. The object is now in Edit mode. Enter text in the Tags field or select from the auto-generated
tags, separating each tag with a comma.
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3. Click € 1o finish.

The Tag Cloud shows you all the tags that are associated with objects in CNM. There is a ranking
system for tags that determines the presentation of the tag text in the Tag Cloud. As objects are
tagged, CNM tallies which tags are being used most often. The tags that comprise the top ten
percent of use are shown in a larger font and with a bold style. The tags that are in the next thirty
percent of object use are displayed in a larger font, but are not in a bold style. The remaining tags
are displayed in regular size and font. This behavior is seen in the example below.

=l Tags

aeg cnm fusion grea Iidea

In the Tag Cloud all the tags are displayed as active links. When you click a tag link CNM runs a
search and retrieves all the objects that have that tag associated with them. The results display in a
Search Results table in the Browse tab as seen in the example below:

[zl Search Result

vews | % | &

Yoaeyz% Al Al =] [y
Narng Number Tag Status Type Date Created

. Single-lens refl... |PO0016 camera Review Product 12M %2010 09:55:0...
"Q'Epy HD camera! |IDEADDDE3 camera,battery Pending ldea 121572010 09:58:0..
'ﬁ'Vuice activated... | IDEAQOD4E camera In Progress DD ldeat 12152010 09:58:5...
Qﬁ. tiny HO camera | IDEADDOET camera In Progress ldea 121572010 10:00:5.
._~Camera - Baseli...|POOOTT camera,photograp... |Approved Product 122010 11:57:4..,
Qﬁ. tiny HO camera |IDEADDTT3 camera In Progress ldea 121572010 11:57:4.
"‘:"Vuic& activated... | IDEAQQ1T4 camera Review Ideat 121572010 11:57:4...
"Q'Epy HD camera®! |IDEAQOOTTS camera Review deat 12M 52010 11:57:4..,

The search executed by clicking the tag has the same limitations as any other search in CNM. If
you do not have access to all the objects that fall within the tag category you selected, then you are
only shown the objects that match your tag search that you also have access to in the Search Results
table. For more information about searches, see Searching in CNM on page 10. If you click a tag
link and no rows are displayed in the Search Results table, then you do not have the privileges
required to access any objects associated with that particular tag because you are not a team
member of any objects that have that particular tag.

Create

A user with a Participant role level or higher can create a new object by clicking the Create button.
To learn more about creating an object, see Creating an Object on page 17.

8 Agile Product Lifecycle Management



Chapter 2: Exploring the Home Page

Favorites

The Favorites option provides a way to organize your favorites selection through the Manage
Favorites... option. There is also a list of any object type you added as a Favorite link. To learn more
about working with Favorites, see Using Favorites on page 18.

Recents

The Recents dropdown menu contains a list of the last ten objects that you have most recently
opened shown with the icon and several characters of the object's name. If you hover over any of
the objects in the list, a tooltip displays the object number. As you create new objects, they are also
added to the Recents list of objects.

When you select an object in the list, you are taken directly to that object's Summary section. If any
object is opened, it is then added to the top of the list of Recents, the other entries are moved down,
and the eleventh entry is removed from the list.

Recentz -

EE idea_4
[ Req 3
.~ Quote_3
O idea_3
[ Req 2
[ Reg_1
Quote_2
.+ Quote_1
O idea_2
Q- idea _1

If you open an object that is already present in the Recents list, the newly opened object is moved to
the top and the list rearranges according to chronology. Objects that are not explicitly opened by
you, such as an object added to another object's structure, are not added to the Recents list. The
content of the Recents dropdown list is specific to your activities and is carried across user sessions.

Tools

The Tools menu has the following two options:
o Import
o View Deleted Objects List

Import

CNM's Import feature supports the following operations:
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o Import to update existing objects in the system (CNM server) in the Microsoft Excel format
o Create objects by using the Import process to import directly from Microsoft Excel worksheets

o Used in conjunction with export to mass update multiple objects in a hierarchy structure

For more information about the Import operation, please see Exporting and Importing Objects on
page 47.

View Deleted Chjects List

The Deleted Objects List is maintained by the CNM application and cannot be altered or removed by
any user. The list displays all the objects that have been deleted by CNM users in a table format
and can be sorted by any of the column headers.

To view the Deleted Objects List:
1. Click the Tools link.
2. Select the View Deleted Objects List from the dropdown list menu.

3. The Deleted Objects List window appears with Type, Number, Name, Date Deleted, and Deleted By
columns.

4. Click | %% | {6 finish.

Searching in O\NM

The Search utility is found in the top right of the application as well as the Browse tab.

Welcome Neal Smith | Administration | User Preferences | Help | Logout (]

Quick Search

The Quick Search has the option of filtering your search parameters by choosing to search through
all objects or only a specific object type.

E!lall All W

Quote
ldea
Requirement

Once this is selected you can search for objects in CNM by typing text into the search field and
clicking Execute Quick Search @, or clicking Enter on your keyboard. Searching for objects initiates a
search of text, multitext, flex, and list fields in objects, which includes Name, Number, Description, Tags,
Rich Text, Notes, Comments, Attachment Names, and Attachment Descriptions. There is a system
setting to include searching attachment content that the Administrator needs to set to Yes. For more
information, see Establishing System Settings on page 72.
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Advanced Search

You can access an Advanced Search within the Browse tab. The Advanced Search section has
several criteria you can adjust to filter your search results and find the object or objects you are
looking for. After expanding the Advanced Search section you are presented with the following:

EAdvanced Search
Match & Al any

Type |Equa|tc| jl LI Tag |Equa|tc| LI
Name/Mumber/Desc IW Rich Text ICuntﬂins ;I
Name |C-:|ntain5 j Date Created Im %
Description ICuntains ;I Date Modified Im %
Nurnber |C-:|ntains j Created By IW

Select the criteria for each field, whether you want your search operator to be Equal to, Does not
Contain, and so on. Then type in the search string you desire. For the DateCreated and DateModified
fields, select your search operator to be On or After, Before, and so on, but not Equal To. Then click

Select Date ® and choose the date you require for an accurate search result. Click - =530 | to
execute your advanced search.

Note For the Date Created/Date Modified criteria, the time stamp used is 0:0:0.

If the criteria you entered is not what you want, or the results you see are not what you need, click

Reset | {0 clear all the fields and begin again.

Search Results

The results of both search types are displayed in a table format, as seen below:

=l Search Result

View v 5 ‘ El
All - All

Name Number Type Tag Status Dezcription
L Single-lens refl... |POO01S Product camera Review A zingle-lens refle...
"‘:;'Spy HD camera! |IDEADDDE3 ldea camera Pending
'ﬁ'vuice activated... | IDEADDO4E ldea camera, battery In Progress If a camera could h...
QA tiny HO camera | IDEADDDET ldea camera In Progress There seems to be .
\._rCamera - Baseli...| POOOTT Product camera, photograp... |Approved Baseling of Camer...
QA tiny HD camera |IDEADDIT3 ldea camera In Progress There 2eems to be ...
"‘:l"‘\.-‘uice activated... | IDEADDIT4 ldea camera Review If a camera could h...
'ﬁ'Spy HD camera! |IDEADDTTS ldea camera Review
@ Convert the em... |REQO0OS9 Requirement camera Approved Even mobile phone...
QA tiny HD camera | IDEADDZ0S Idea camera In Progress There seems to be ...
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The Search Results table allows you to view essential data about a set of objects, such as the status
or who created the objects, and then select the result that best matches your query. The Name and
Number columns have active links that take you directly from the Search Results table to the object
you click. You can sort all the columns in a descending or ascending order and also rearrange the
order of the columns displayed.

Search results for CNM objects are contingent upon the team assignments of objects. If you are
part of the team of an object, either as an individual or as a member of a user group added as team
members, the object displays in the search results. If you are not a team member, even if an object
matches your search criteria, it does not display in the search results.

Note Search results are limited to 5000 entries.

Query By Example

The column headers have text and list input fields where you can enter text strings to filter your
search results down to a smaller set of results more pertinent to your needs. Clicking the Query By
Example button activates and deactivates these text input fields above the column headers. After
entering in the text you want, you need to click Enter on your keyboard.

Exporting Search Results

koA
You have the ability to export your entire search results, or selected results, when you click & in
the Search Results window. For more information, see Export from Search Results.

Resetting Search FHlters

A user can clear the entered text strings from the column header filter boxes by clicking the Reset
Filter button. This lets the user enter a different search filter that is applied to the original, unfiltered
results. Once the user clicks Enter the results refresh with the new results.

Copy to dipboard

From any search results in CNM a user can right-click a row or cell and access a Copy function. This
copies the currently selected object (not cell) to an internal CNM clipboard. A user can now navigate
to a structure of an object in the Explorer area and paste the copied object as an addition to the
structure.

View

Tables have a View utility to change the column layout. From the Columns option you can select Show
All or you can select specific columns to display. Each column header name has a checkmark next
to it if it is displaying. Click the column name from the Columns list options and it will de-select that
column and the table will automatically reload without that column.

12 Agile Product Lifecycle Management
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From View you can also select Reorder Columns... and the Reorder Columns window appears as seen
below:

Reorder Columns [%]

Vigible Columns

[JRewv

Status

Type

Oy =
o
-
=

QK Cancel

In this window the available columns are displayed with a checkbox next to each. Check the box of
the column(s) you want to reorder and then choose to move the item(s) to the top of the list or to

move the item(s) up one position in the list. When you are finished click 0K and the table you
have open will automatically shift column positions to what you selected.

Note The Add Reference window does not allow moving the first column Number out of its default
order.
Table Column Drag and Drop

To illustrate the drag and drop column behavior available in tables, see the example below.

Open an object that has child objects, such as QuoteX. Click B3 and the page is redirected to the
Structure Table View where you can select a column to rearrange, such as Object Number.

'@'T‘,rpe Description Tags | Object Number tatus Date Created |Date Modified

Name L Type Description Tags |Object Number |Status Date Created |Date Modified
@Type Description Tags |Object Mumber |Status Date Created |Date Modified

B 2 QuoteX Quote This is needed. QUOTECOOSS  |Pending |2010-02-24 .. |2010-02-24 ..
@Req'l Requirement |Thiz iz wonderful |fusion |REQQ1296 Review |2010-02-24 ... |2010-02-24 ...

= @ RegB Requirement |This is awesome |fusion |REQN1254 Approved| 2010-02-24 ... |2010-02-24 .
"Q"Id eal |ldea cnm  |IDEAODOZSS Pending [2010-02-24 ... [2010-02-24 ..

'ﬁ'ld eall |ldea cnm | IDEAOO300 Pending [2010-02-24 ... |2010-02-24 ..

@ Regy Requirement |This iz perfect fuzion |REQO1252 Review |2010-02-24 . |2010-02-24 .

vl
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Drag the Object Number column away from its present order.

-?:F-Typ.e Description Tags Status Date Created | Date Modified
Hame DT}rpe Dee=cription Tags Status Date Created |Date Modified
 ——
Ohbject Mumber
@T}rpe Description Tags us Date Created |Date Modified
B ©_rauotex Ql.n:lte This is needed. Chject Mumbet  hing  [2010-02-24 . [2010-02-24 .
@ Reg1 Reguirement |This iz wonderful |fusion ——ew [2010-02-24 . |2010-02-24
= @ ReqB Requirement |Thiz iz awesome | fusion Ohject Mumber  droved|2010-02-24 ... |2010-02-24 ...
‘QrideaC  |idea cnm oUOTEDDDSE  ping  [2010-02-24 . (2010-02-24 ...
"Q"H:Ieau ldea cnm W Hing |2010-02-24 .. [2010-02-24 ...
E Reqv Requirement |This is perfect fusion REQOMZa4 W |2010-02-24 . |2010-02-24
IDE&ADOZ9S
DEAINZ00 |
ez |

Find the column placement you want for Object Number and release the column into the blank

column space.

Q- Type Description Tags |Status |Date Created Datf: Modified
Chject Mumbe L
Name DT}rpe Description Tags |Status Date Created tg Modified
Object Mumber
ET}rpe Description Tags |[Status Date Created te Modified
= [ Quotex aliote This is needed. Pending |2010-02-24 || it Mumber b oo e
[E req1 Requirement |This is wonderful |fusion |Review |2010-02-24 .. QUOTENDDSE -02-24 ...
= [ ReqB Requirement |This is awesome |fusion |Approved|2010-02-24 . REQ071236 -02-24 ..
‘QideaC  |idea cnm  |Pending [2010-02-24 || RE@01234 -02-24 ..
‘Qidead |idea cnm  |Pending |2010-02-24 || [DEAQD299 -02-24 ...
E reqv Requirement |This is perfect fugion |Review |2010-02-24 .. IDE 200300 -02-24 ...
REGO1 252
L/
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The Object Number column is now moved to a new location and order in the Structure Table View.

-‘Q’-Type Dezcription Tags |Status Date Created |Object Number |Date Modified

Name L Type Description Tags |Status Date Created |Object Number |Date Modified
@T}rpe De=cription Tags |Statuzs Date Created |Object Number |Date Modified

B " _rQuotex Quote This iz needed. Pending |2010-02-24 .. |QUOTEDOOSS  |2010-02-24 ..
@F‘.aﬂ Requirement |This iz wonderful |fusion |Review |2010-02-24 ... |REQ01Z58 Z010-02-24 ...

= @ Reqb Requirement |This iz awesome |fusion |Approved|2010-02-24 . |REQ01294 2010-02-24 .
"Q"Idesc ldea cnm  |Pending |2010-02-24 ... IDEAQDZ59 Z010-02-24 ...
"Q"Ideam ldea cnm  |Pending |2010-02-24 ... |IDEAOO300 2010-02-24 .

@Req‘r’ Requirement |This iz perfect fusion |Review |2010-02-24 ... [REQQ1252 Z010-02-24 ...

User Preferences

A CNM user can access some personal user interface settings from User Preferences.

Any changes made to the User Preferences will not take effect until you log out of CNM and log
back in for another user session.

.3

User Preferences (%]

Number Format |ga7 654,321.09 |

Language |Eng|i5.h LI

Time Zone | (GMT+00:00) Greenwich Mean Time : Dubiin, Edinburgh, Lisbon, London ¥

Time Format | hh:mm:ss aaa z (10:00:00 AM PST) =]

Date Format IW 'I

Help Save Cancel

CNM is available for localization with the following languages: English, French, German, Japanese,
Korean, Russian, Simplified Chinese and Traditional Chinese. These are the available values from
the Language dropdown.

Help

To access Oracle's Agile Product Lifecycle Management Customer Needs Management help

materials, in the top right corner of CNM click . A new window launches that has the help
materials available for you. There is also help available from many of the action windows in CNM.
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When you click Help , @ new window launches where you are directed to the configured online

help materials, or to an Oracle's Agile Product Lifecycle management User Productivity Kit (UPK)
menu. Your CNM administrator needs to have previously configured an Online Help URL setting in
System Settings in order for this to be an active link. It is possible that the Help link directs you to a
User Productivity Kit (UPK) menu where you can choose different online help topics that guide you
through specific actions in CNM. For more information, see Establishing System Settings on page
72.

Logout

To end your user session, click in the top right corner of the CNM application. You will be
immediately directed back to the Login page with the Username and Password fields blank.

Important A user session that is idle for 25 minutes will automatically end the user session and
when you attempt to perform any action you are directed back to the Login page.
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This chapter includes the following:

Creating @N ODJECE......c.iireiceceee bbb bbb bbb 17
ACCESSING ODJECES ....o.viviviiecreiict ettt bbb bbb s bbbttt bbb 18
LeVeraging the SE AlSO..........cu bbb 26
Managing ODJECE TEAIM ......c.oviuiiiciei bbb bbb 27
WOTKING WIth EXPIOTET ..o bbb 30
ODJECE SIGNOTTS ...v.voivcviiecteecte et bbb bbb a bbbt bbbt b a s aee 38
Performing More ODJECE ACHONS .......c.cvcuiviiiciice ettt b e bbb bbb 40

Creating an Object

There are several places to create an object in CNM. The following sections cover the object
creation process:

o

o

a

o

Home Page
Import on page 53
Save As

Explorer

To create a new object from the Home Page:

a r w DR

Click Ekall

The Create window appears. The Number field is autogenerated with an autonumber.
Choose the type of the object from the Type dropdown menu.
Enter a name in the Name field (that does not exceed 128 characters).

You have the option to enter a description (that does not exceed 4000 characters) in the
Description field.

When finished click Create. A tab opens up with the newly created object open in an edit mode
where you can fill in more details.

Note The creator of an object is always added to the Team list. If the object type has a

configured default value for team, that default value is also added to the Team list. For
more information see, Managing Object Teams on page 27.

vl
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Accessing Objects

There are several places that you can access an object in CNM.
Recent Updates — from the display of object activity, click the link to the object you want to view
Favorites — from the list of your added favorites, choose the specific object you want to view

Recents — from the list of the last ten objects that you have accessed, choose the object you
want to view

Tag Cloud — from this area, click the tag you want to run a search for all objects that have that
specific tag associated with them and then click the object you want to view

Search — from the search field, execute a search for an object with specific criteria and
parameters and then click the object you want to view

Explorer — from the displayed structure of an object and its child objects, click the child object
you want to view

Where Used — from the Where Used table, click the parent object link to view the object

Favorites

If there are objects that you need to return to frequently, using Favorites helps you find them easily.
The Favorites dropdown menu stores a list of the objects you added as favorites. Any object type
can be added to your Favorites list and the object icon and name are visible in the dropdown menu
of Favorites. The list of favorites is specific to the user.

Once you select an object from your list of favorites you are directed to the Summary section of that
object. If you no longer have the necessary role to access this object, or if this object is deleted, you
will receive an error message.

Adding Favorites

The Add to Favorites option is available to you from the More Actions menu. Once you select Add to
Favorites the object currently open is added to the list of objects under Favorites.

Managing Favorites

The Manage Favorites... option is available from the Favorites dropdown menu to delete previously
added objects as favorites.

To delete an object from the user's Favorites list:

Manage Favaorites...
1. From the Favorites dropdown menu click

2. The Manage Favorites window appears.

3. Click the row of the object you want to delete.

4. Click X to delete the entry from the list.

18 Agile Product Lifecycle Management
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5. Click %% | to finish.

Summary

The Summary section of an object displays the following information:
o Name

o Description

o Status

o More Details

o Edit
More Details

When the More Details section of an object is expanded you can view additional attribute information
pertaining to your currently selected object such as Tags, Date Created, Created By, and so on. All of
the flex, or custom, attributes enabled for the object type by the administrator are displayed.

Rich Text

The Rich Text attribute for objects presents a way for users to enhance the content quality. Users
can enter or paste formatted text in the Rich Text field. When pasting content, any hyperlinks are
automatically opened in a new window when they are selected by a user.

Details
[Font e Bl al Mal F
BIU 885 = = E

The text content of the Rich Text field is indexed for searching in CNM, just like the contents of any
other text field. The Rich Text field is available as one of the fields in Advanced Search when it is
enabled. The set of filters for this field are the same as that for any text field. However, the Rich Text
field is not displayed as a column in search results and cannot use the Query By Example
functionality. When exporting an object to XML, the formatted content of the Rich Text field (rendered
in the form of HTML) is exported. Rich Text fields are not exported to Excel.

The Rich Text attribute is a hidden attribute by default. The administrator needs to make this field
visible in order for users to have access. For more information, see Object Attributes on page 61.
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Modifying Object Attribute Details

To modify attributes of an object:

1. Open an object.

In the Summary section click 4 .

3. The Summary and More Details sections expand and editable attribute fields are now in Edit
mode.

4. Enter new values of attribute fields and then click Save to finish.

Attachments

Important In order for Agile PLM and Agile CNM integration to work for the Attachments and
References, a user must deploy the agile-cnm-plugin.jar file to the Agile PLM server.
Please refer to the CNM Implementation Guide for details.

There is an Attachments & References section for all objects. If your administrator has selected Agile
PLM as the file server, then Agile PLM is also used for user authentication. If the administrator has
selected UCM as the file server, then LDAP or Agile PLM are used for user authentication.

A user with a Participant role or higher can add, view, or remove attachments and references. A
user with the Viewer role can only download or view attachment files, URLs or References.

Note If Agile PLM is the selected file server, then to work with attachments in CNM, a user
needs to have the proper file folder privileges in Agile PLM. See the Agile PLM
Administrator Guide.

Adding Attachments

For more information about the availability of adding attachments, the required settings, and the
Agile PLM file folder subclass relationship to CNM attachments, see Establishing System Settings.

Important It is necessary for a file server (Agile PLM or UCM) to be installed and configured
outside of CNM in order to upload and retrieve file attachments in CNM. If this has not
been performed properly prior to adding attachments, you will not be able to add
attachments because the Add File option is disabled. For more information, see
Establishing System Settings and refer to the CNM Implementation Guide for specific
file server information.

To add an attachment file:

1. Go to the Attachments & References section of an object and click =+ .
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& .
2. From the list menu choose O T |

In the Add File window click to choose a file to upload.

4. Inthe Choose File window navigate to the location of your file, select the file to attach and click
Open.

5. Enter any desired content in the Description area of the Add File window and when finished click
0K

6. If you click and select a file that is already an attachment, CNM displays a
Confirmation window that prompts, "File <attachment> already exists on <object>. Please
confirm to overwrite."

Cancel

7. Click 2K to confirm, or click to not overwrite the file.

Note If the Agile PLM file server is used and the user has the necessary privileges, when the
user adds a file attachment to a CNM object, then a corresponding file folder object is
created in Agile PLM and the file is added to the Files tab of the file folder object.

To add an attachment URL:
1. Go to the Attachments & References section of an object and click % .

. +
2. From the list menu choose & URL

3. Inthe Add URL window enter text into the URL field and any desired content into the Description
field.

4. Click 9% to finish.

If you add a URL that is already on an object, CNM automatically overwrites the previous entry and
displays that URL as the latest entry for attachments.

Note If Agile PLM is the selected file server, then to work with attachments in CNM, a user
needs to have the proper file folder privileges in Agile PLM. See the Agile PLM
Administrator Guide.

Viewing Attachments

Once attachments are added to an object, they are displayed in reverse chronological order with the
most recent being found at the top of the list. Once the object has an attachment in the Attachments
& References section, the following information is displayed:

o Attachment type icon
o View icon
o Fulfiled Checkmark

o Delete option
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@ Attachment Name

o Attachment Description

o File size

o First Name and Last Name of the user that added the attachment

o Date and Time the attachment was added

[ Attachments & References

=5 # http:ihwwrw bestinformation.c... Mariah Thomas 020092011 09:02:07 PM GMT
") ® PO00OOS test Mariah Thomas 02/09/2011 09:01:35 PM GMT
&a ® TOC1 bmp Thiz iz great. 1,164,888 Mariah Thomas 02/09/2011 08:59:44 PM GMT

To view an object's attachment:
1. Go to the Attachments & References section of an object and click the attachment filename.
2. From the File Download window choose whether you would like to open or save the attachment.

3. If you choose to save the file, pick a location locally on your computer to save the file and then
click Open.

4. After you click Open the file opens and you can view the content. You can open the file using a
native application or save it to your hard drive.

5. Clicking &3 |aunches the viewer to see the attachment file directly.

Note If Agile PLM is the selected file server, then to work with attachments in CNM, a user
needs to have the proper file folder privileges in Agile PLM. See the Agile PLM
Administrator Guide.

Important If the necessary AutoVue has not been installed or is experiencing its own application
errors, then you cannot successfully view your attachments in a browser. For more
information, see Establishing System Settings on page 72 and refer to the CNM
Implementation Guide for specific AutoVue information.

Removing Attachments

To remove an object's attachment:

b

1. Go to the Attachments & References section of an object and click next to the attachment or

reference you wish to remove.

2. You are then prompted in a Confirmation window, "Confirm deletion of the <attachment type>:
<filename>."

3. Click 2K to confirm and finish.

If the UCM file server cannot be reached, the attachment is still removed and a message displays
stating that the corresponding file needs to manually be removed from the UCM file server. If the
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Agile PLM file server cannot be reached, the attachment is still removed and a message displays to
the user stating that the corresponding file needs to manually be removed from the Agile PLM file
server. If the user does not have the user privileges to delete folders in Agile PLM, the CNM
attachment is still removed and the corresponding folder still needs to be manually removed from
Agile PLM.

Note If Agile PLM is the selected file server, then to work with attachments in CNM, a user
needs to have the proper file folder privileges in Agile PLM. See the Agile PLM
Administrator Guide.

References

A reference is an index link to a record present in an external system. References bring greater
enrichment of CNM data with existing product designs or projects. References also provide
backward traceability from products and projects in the Agile product lifecycle management system
to the CNM requirements that led to those products or projects.

References are available on reference-enabled objects to increase the association of CNM objects
to Agile product lifecycle management system objects. User authentication needs to be set up
against the Agile product lifecycle management system in order for the Reference option to be
available in the Attachments list menu.

Adding References

To add a reference to an object:

1. Go to the Attachments & References section of an object and click =+ .

' Ref
2. From the list menu choose *iy Reference

3. Inthe Add Reference window select the object type of Items or Projects, enter your search text
string, and click @ .

4. You can then drag your desired reference item from the Search Results table to the Attachments &
References section, or select the item in the Search Results table and click 0K to finish.

The Add Reference window, mentioned above, allows you to search for an item or project and see the
results in a table format to select the desired reference.
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Note The results are limited to 1000 entries.

Add Reference (%]
ers RINRE @
Search Resultz
View »
Number Dezcription Status Type Rev
(9009-001-X055  [This is an important part. Preliminary  |Part
21 008-001-X155 Preliminary  |Part
334-1008-02 Production  |Part M
DDDDEE Thig iz an impertant document Preliminary  |Document
. 550 Production  |Part i
@m_s50 Production  |Part 01
@ roooss Preliminary | Diode
alron1ss Prefiminary | Aszzsembly
alron2ss Thig iz an important part. Preliminary  |Part
Total Rows 9
Help 0K Close

You can expand the search result assemblies to display the first level of BOM items and add either
assembly or any first level BOM item as your desired reference. The displayed attributes of items or
projects within the search results is dependent on the Agile PLM settings for those attributes. If an
attribute is enabled for the BOM table within Agile PLM then the search results in CNM will display
the attribute.

Note In order to add a Project as a reference, the user needs the Read privilege for General
Info.Number in PLM enabled. This privilege is not assigned to the default roles and
therefore may require the administrator to grant users this privilege.

From the Add Reference window search results you can drag and drop items from the table into the
Attachments & References section to add the object as a reference. The ability to drag and drop
references includes not only the currently open object, but also any object that is displayed in the
open Explorer structure. For more information on dragging and dropping within an Explorer structure,
see Rearranging an Object Structure on page 34.

If you add a reference that is already on an object, CNM overwrites the existing reference and
moves that reference to the top of the list. The action of adding references to objects in CNM also
produces a cross reference for that reference object in its native application. For Item object
references, the cross reference is a URL present on the Attachments tab, and for Project object
references, the cross reference is a URL present on the Content table.
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Viewing References

To view an object's reference:

1. Go to the Attachments & References section of an object and click the active link of the reference
name.

2. You are brought to the native application of the reference.

3. The application directs you to the Cover Page of the reference object.
Removing References

To remove a reference from an object:

&K

1. Go to the Attachments & References section of an object and click .

2. You are then prompted in a Confirmation window, "Confirm deletion of the Reference:
<reference_number>."

3. Click 2K to confirm and finish.

The action of removing references from a CNM object also removes the cross reference for the
reference object in its native application.

Note If the reference object business rules (Roles, Privileges, State, Lifecycle, Workflow, and
so on) do not allow the cross reference to be removed from either the Item Attachment tab
or the Project Content table, then the server does not remove the cross reference and the
cross reference link is only removed from the CNM Attachments & References table.

Fulfilled Attachments and References

Attachments and references have a checkmark icon to indicate if that particular attachment or
reference fulfills a requirement outlined by the object or project. The checkmark becomes blue to
indicate that the attachment or reference fulfills the requirement. By clicking the icon a second time
you deactivate the checkmark and the icon returns to a gray color.

g

If a file attachment is replaced by a file that has the same filename, the current status of the fulfilled
checkmark remains the same. When a user performs a save as operation from an object with
attachments or references in a particular state of fulfillment, the current state is transferred to the
new object for those attachments and references. Once an attachment or reference fulfillment
status indicator is modified (checked/unchecked), that attachment or reference is immediately
moved to the top of the Attachments and References table.

Notes and Comments

There is a Notes section of objects that allows notes and comments to be added. All users can post
a note or comment. As notes and comments are posted they are displayed in reverse chronological
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order with the most recent seen on top. The content of each comment is displayed below the note it
is connected with, but is indented. With each note or comment, the name of the user and the time
that he/she added the comment is logged.

To add a note to an object:

1. From the Notes section click 'ii' .

2. Inthe Add Note window enter your text into the required Note field.

3. Click 2% to finish.

To add a comment to a note:
1. Go to the Notes section of an object.

2. Find the note you want to add a comment to and click #3%

3. Inthe Add Comment window enter your text into the required Comment field.

4. Click 9% to finish.

Only a user with the Administrator role can delete notes or comments. If you have Administrator
access, a Delete link is available at the end of each note or comment.

To delete a note or comment from an object:

1. From the Notes section click the expand icon .

2. Navigate to the note or comment you wish to delete and click [C=it= |

3. You are then asked, "Do you want to delete the selected note/comment?"

4. Click 9K to confirm and finish.

Leveraging the See Also...

CNM objects have a See Also... section that helps users see correlation between objects in the CNM
system.

El See Also...
(64%}¢' camera

(61%)g- A tiny HD camera
(57%)Q" SLR Lens

The display shows a percentage, an object type icon and an active link of the object name. Each
object has a set of object keywords, which are generated using the algorithm described in the
Keyword Generation section. Using an object's keywords, CNM finds similarities with other objects
in the system and associates these objects together for the user in the See Also... section. The
percentage of similarity is calculated between the objects within CNM and only the top five
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associations are included in the See Also... section.

Note If you are not a team member of an object, the object still displays in the See Also...
section, but you cannot navigate to it.

If a user modifies an object in such a way that content used for keyword association changes, the
See Also... section only refreshes once the object is saved. For more information about keywords,
see Keyword Library on page 70.

Managing Object Team

When you are viewing an object there is a collapsible and expandable right pane Team area where
the currently assigned team members are displayed.

HTeam op 3§ 3 dy

Admin CNK
IMariah Thomas
Meal Smith

You can add or remove team members if you have a Participant role or higher. The creator of an
object is always added to the Team list. If the object type has a configured default value for Team,
that default value is displayed in the Team area. When user groups are deleted by an administrator
they are automatically removed as team members for objects they were associated with.

Important If you modify the team of an object so that it removes you as a team member, whether
it is specifically removing your user name, or it is removing all user groups you belong
to, once you save that change and navigate away from the object, you will no longer
be able to open that object. If you try to open that object in the future, you will be
alerted that your access is denied because you are not a team member of the object.
If any user with a Participant role or higher removes all the teams from an object, the
object is no longer accessible by any user.

Adding a Team

To add a team member to an object:
1. Open an object.

2. Inthe right pane go to the Team area.
Click W .

In the Add Team window search for a user(s) or user group(s) to add to the object.

5. Select the desired entries and click ﬂ

Apply & Cloge

. When you have chosen your last selection click

to finish.
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Object Structure Team Association

Team members are also an inherited association between objects. When an object is added to the
structure of another object, the parent object's team is added as a team for the newly added object.

Also, when an object that has a child structure is added to a parent object as its new child object
within an existing structure, any team members from the parent object are associated to all the
children objects of the newly added object. To illustrate this behavior, see the example below.

Create an object QuoteX with a child object ReqY, which also has a child object IdeaZ.

B QuoteX

..................

..................

Next, add yourself as the only team member of all three objects. In this example your user name is
Mariah Thomas.

Note You may need to remove any default teams for these objects to be sure that the only
team member is you.

ETeam ofp 38 3 dg

Iariah Thomas

Create a new object QuoteA with a child object RegB, which also has a child object IdeaC.
E ' QuoteA

Add yourself, (Mariah Thomas), as a team member to all three objects and also add a user group,
such as Cats, to all three objects as a team member.

[l Team 4&&9&

Iariah Thomas
[Catz]
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Open QuoteA and click =+ in the Explorer area to add an object to the structure of object QuoteA.
From the Add Team window choose the object QuoteX that you created earlier, which does not have
the team member Cats. The structure of QuoteA now appears like this:

E iQuoteA’
E " QuoteX
= = Reqy
Y ldeaz
= = ReqB
Q ldeal

In the Team area of QuoteX, ReqY, and IdeaZ the user group Cats has automatically been inherited
since it was a team member of the parent object QuoteA.

[l Team 4&&&

Iariah Thomas
[Catz]

Removing a Team

To remove a team member from an object:
1. Open an object.

2. Inthe right pane go to the Team area.

Select the team member(s) you want to remove and click X .
4. A Confirmation window appears:
& Confirmation (=]

Once the usger(z)/u=er group(s) are removed they can no longer access the object. Do you want to
continue?

Cancel

|

5. Decide if you want to remove the team member from all the objects in the structure and click
Continue

to finish.

Caution If you remove yourself, or your user group, you no longer have access to the object,
even though you are performing the action.
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Working with Explorer

When you are viewing an object there is a collapsible and expandable left pane Explorer area.

Explorer

& & X H @

= Fo] = Reql
Eal " iwear
Q ldead
= Q Idead
2 ¥ Quotes
=4 B Reqs
Y ldeas
= ¥ & ReqgB
¥ Y ldeac
Y ldeaa
=RE] Regy
s IdeaF |

Note By default, a user sees the structure of an object with its child objects expanded to only
one level.

The Explorer area has the following actions available:

o Create — add an object to the current structure by creating a new object

o Add — add an object to the current structure by searching for an object

o Remove — remove an object from the current structure

o View — view the object attribute details for every object within the multi-level object structure in
a table format

o Refresh — refresh all levels of the object structure and collapse the child levels

All object types can be a part of an Explorer structure. From the Explorer structure you see the status
of each parent and child object giving you an overall perspective of the progress of each element
within an entire project hierarchy. The icons associated with object status can each be unique and
controlled by the administrator from the Administration section. For more information, please see
Status List on page 65.

Like the search results restrictions, if you do not have access to an object because you are not a
team member, the object does not appear in the Explorer structure. If you select a child object from
the Explorer structure, the child object's Summary section opens, but the Explorer pane still provides

30 Agile Product Lifecycle Management



Chapter 3: Working with Objects

the structure of the initially open parent object. As objects are added, removed, or rearranged, the
Explorer structure will update the arrangement of child objects alphabetically.

Qreating New Qbjects from Explorer

To create a new object from the Explorer menu:

1. Inthe Explorer structure of an object, select the object you want to create your new object
under.

From the Explorer menu click .

3. The Create window appears. Choose the object type from the Type dropdown list and enter a
name in the Name field.

4. Click 2% to finish that object creation process.

You can continue to create more objects that are automatically added to the Explorer object

k Cloze

structure, or clic to finish.

The creation process can continue seamlessly by clicking Enter on your keyboard after each
creation. Once the Create window is open, you can navigate to different object structure levels of
parent and child objects in the background and return to the Create window to continue creating
objects to add to the structure level that you navigated to.

As you create (or add) objects that become child objects in a structure, the team of the parent
object is added to all the child objects automatically, so that you now have access to all the child
objects created (or added). For more information, see Object Structure Team Association on page
28.

Adding an (hject to a Structure

To add an object to a structure:

1. Inthe Explorer structure of an object, select the object you want to add your object under.

2. From the Explorer menu click + .

3. Inthe Add Structure window select the type of object you are searching for, enter your search
text string, and click @.

4. From the Search Results table select the object you want to add and drag it to the object
structure level you want, or click 9% to finish.

Child objects added to a structure are displayed at the level of the structure that was selected and
highlighted before the add action began. If you drag and drop an object(s), you can determine which
object in the structure you would like to be the parent object, regardless of what was previously
highlighted.

From any search results in CNM a user can right-click a row or cell and access a Copy function. This
copies the currently selected object to an internal CNM clipboard. A user can now navigate to a
structure of an object in the Explorer area and paste the copied object as an addition to the structure.
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To paste an object into a structure:

1. From a Search Result table, highlight the row(s) you want to copy and right-click.

2. Click Copy.
3. Inthe Explorer structure of an object, select the object you want to add your copied object(s)
under.

4. Right-click and select Paste.

For more information about the right-click menu in the Explorer, see Viewing an Object Structure on
page 33.

Object Structure Duplication and Recursion

The rules governing the structure of an object provide a way to prevent unnecessary duplication
and recursion of objects. CNM does not allow repeated objects at the same structure hierarchy level
of an object. To illustrate this behavior, see the example below.

Open an object that has child objects, such as ProdX. Expand the object structure and see its child
object IdeaQ. Be sure to still have ProdX selected and highlighted.

Q idea?
EY igeas
= Q ldead

2 ¥ quotes

2 ¢ EH Regs

¥ ldeas
= v [ Reqh

% ldeac
¥ § ldean

Click e and search for Reql. Select Reql from the Search Results table and click .5

You are then prompted with, "Adding duplicate child <Req1> is not allowed". Click 2% to confirm
and the action does not take place.

Note CNM decides if an object is being repeated according the object number. If there are two
or more objects with the same object name, but with different object numbers they can
be placed at the same level in an object structure.
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Regardless of whether or not you can currently see parent objects, CNM will not allow parent
objects to become child objects of an already existing child object of its own. The Where Used option
from the More Actions menu will show you whether or not the currently displayed object also has a
parent object that is not shown in the Explorer area. For more information about the Where Used
option, see Where Used on page 46. To illustrate this behavior, see the example below.

Open an object that has child objects, such as ProdX. Expand the object structure and see its child
object IdeaQ.

B 3 rodk
2 D Reqt
@ idea7

EY igeas
= Q ldead
2 ¥ quotes
= v HE Reqgs
¥ ldeas
= v [ Reqh
" ldeac
¥ dean

Click IdeaQ, then click - and search for RegB. Select ReqB from the Search Results table and
click 9K

You are then prompted with, "Recursion found for adding object <ReqB>, action denied." Click oK
to confirm and the action does not take place.

Viewing an Qoject Structure

A user can right-click on an object within a structure to bring up a menu for collapsing and
expanding the structure.

[z| Paste

Collapse
Expand All Below
Collapse All Below

If an object is currently only displaying the top level object, the menu will have the Expand and the
Expand All Below options. If an object is currently expanded to all levels, the menu will have the
Collapse and the Collapse All Below options. If the object structure is only expanded to a certain level
with child objects still hidden as collapsed objects the menu will still have the Collapse, the Expand All
Below and the Collapse All Below options.
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For more information about the Paste function, see Search Results on page 11.

Rearranging an Chject Structure

You can rearrange the structure of an object by dragging and dropping child objects from one level
to another.

Note The ability to drag and drop an object is available as long as the entire object name is
visible. If the name is cut off, extend the left pane or rename the object.

Objects may be selected and dragged one at a time. As the pointer is dragged through the
structure, a highlight is shown on each object as it is passed over to indicate that object will become
the new parent object if you drop your selection there. To illustrate this behavior, see the example
below.

Open an object that has child objects, such as ProdX. Select one of its child objects, such as Idea9.

Explorer
+ X = @
= B prodx
El Fo] == Reqgi
Q ldea?
Q Idead
=V eag
= ¥ Prods
=i =] Reqs
¥ ldeas
=R = ReqB
G deac
¥ dean
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Now drag Idea9 to another child object, ReqB, and see that the RegB object is highlighted.

0 B proax
= E}lj Redql
BalY gear
:';j'ldeaﬂ
B .
# o Prodg
2 ¥ [ Rens
& F ldess

Once the Re@B object is highlighted, drop Idea9 and it becomes the child object of ReqB.

= B prodx
= Fo]E=| Reqgil
]l ldea?
Q ldead
=R = Reqh
= &V

= ¥ Prods

2 ¥ Bl pegs
¥ deas
¥ deac
¥ deaa

Removing an Cbject from a Structure

Removing an object from another object’s structure does not cause the child object to be deleted

from the CNM application.

To remove an object from a structure:
1. Open an object that has a structure.

2. Click the child object you want to remove.

3. Click x to finish.
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Structure Table View

The Structure Table View is a way to see the object attribute details for every object within a multi-
level object structure.

Note By default, a user sees the structure view of an object with its child objects expanded to
only one level.

To view the Structure Table of an object:

1. Open an object that has a structure.

2. Click ™ |

3. The Structure Table View page appears. Expand all the levels of the parent object to see every
object's attributes.

4. Click | %% | {6 finish.

The Structure Table is configurable because a user can drag and drop columns into the desired
order. For more information about reordering columns, see Table Column Reorder.

Editing Object Attributes in Structure View

Once a user clicks View and is brought to the structure view page of an object, the user can edit
attributes of objects directly from the table display. Only users with privileges to modify objects can
edit object attributes in the structure view. The editable attributes include all flex fields except the
Rich Text field.

xyz123

Save Save and Close
"Q'Type Description Tags Object Number Status Created By Text01 Text0:
Name L Type Diezcription Tags Qbject Number Status Created By text01 Textl:
@T‘_.rpe Description Tags Object Number Status Created By Group
= E"Q"xyz123 ldea IDEADT042 Pending Admin CHNK
= EQm idea IDEADD359 Pending Admin CNK
= E"Q":ﬂ ldea IDEADZ325 Pending Admin CNK
. [idea This is awesome | | good IDEA02326 A Approved | | Admin CNM
Ab Approved
Approved
Approved AA
Canceled
In Progress O
In progress In |In Progress
Pending
Rejected

To edit object attributes from the structure view page:
1. Click View.

2. Click in any cell of an editable attribute.
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3. Once the row of cells becomes editable, enter in the content you want to add or change or
select values from available dropdown menus.

4. Click 52Y& or SaveandClese |y, ah5ly vour changes to all affected object attributes. Click
Cancel

to remove all your entered changes and return to the object tab.

Changes In Process

As changes are made to row cells, a yellow highlight indicator alerts the user that a change was
made as the user navigates throughout different cells. Once the changes are saved, the yellow
highlight indicator disappears and the cells return to their normal state.

Description Tags
Thiz iz great
| need thiz

new

Update Conflicts

It is possible that in the Structure View o fan object there is an object that occurs twice, under two
different parent objects. Because this is possible, it is also possible that a user may make a change
in one instance of the object and enter a conflicting change to the same object elsewhere. CNM will
only apply one change for that object's attribute and there is no way for the user to know which
change will be accepted.

If there is an error in any of the object attributes edited, the Save operation will fail for all changes
made and the user is notified which row cell needs correction before all the changes are saved. The
user can navigate easily to the row cells that need correction as they are marked in red. Then the
user can proceed to save their changes successfully.

Refreshing Qojects in Explorer

Clicking Refresh L reloads the latest changes of an object's structure to reflect the most current
information. If another user is making changes that you need to know about, the refresh feature
makes it possible for you to know what changes have been applied.

To illustrate the Refresh behavior, see the example below.
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Open an object that has child objects, such as ProdX. Expand multiple child object levels of ProdX.

B = iprod
= GE Reqg1
Q idea?
EY igeas
= Q ldead
2 ¥ quotes
= v HE Reqgs
¥ ldeas
=R 0] Reqh
" ldeac
¥ dean

Make changes to the first level child object, Reql, and save your changes.

Another user, UserB, in another session modifies ProdX by removing the child object Reql from the
structure entirely.

Now click @ and see that the child objects of ProdX collapse up to the first child object level and
now Reql is no longer a child object of ProdX.

Explorer
+ X B @

Cbject Signoffs
Sending an Chject for Review

All users with access to an object can be assigned as an approver of an object, but a user group
cannot be assigned as an approver. The Approve and Reject buttons are available only on object
types that have the Allow Signoff property set to Yes. Any user with a Participant or higher level of
access may send an object for review to a team member or members.

To send an object for review:
1. Go to the Team area of an object.

2. Select the member(s) you want to review the object.

3. Click ¥ and in the Send For Review window enter a message for the user(s).
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The team member(s) assigned a review have a Signoff Pending icon beside their user name in the
Team area and the currently assigned object displays in the My Pending Reviews section of the Home
page for the user(s). Once a user approves or rejects the object their icon changes accordingly.

Executing Approvals and Rejections

When a user navigates to an object, any signoff requests or last approval status and information for
that user displays at the top of the object along with a signoff pending or current review status icon
by the user name in the Team area for that object. This lets a user know that he/she needs to
approve an object or if he/she has completed the review.

To approve an object:

1. Open an object and click . “PP/@¥& |

2. In the Approve window enter your comments into the Comments field.

When you are finished click | “#PT®¥& |
The Notes section of the object now contains the approve action and any accompanying notes
entered along with your approval status and the time stamp you performed the action.

To reject an object:

1. Open an object and click Reject

2. Inthe Reject window enter your comments into the Comments field.

When you are finished click | REEet
The Notes section of the object now contains the reject action and any accompanying notes
entered along with your rejection status and the time stamp you performed the action.

Once the user approves or rejects the object, an approved or rejected icon displays next to the user
name in the Team area for that object. A user can sign off multiple times for one object as long as
he/she is still an assigned approver regardless of what the first signoff status was. A signoff

assignment for a user can be reset by clicking the Reset Signoff Lh button, which removes any
signoff icons next to that user name in the Team area. However, that same user can be reassigned
as a reviewer and once again the signoff pending icon displays by the user name in the Team area
and a signoff request alert displays at the top of that object page. For more information about
resetting signoffs, see Resetting Signoffs on page 40.

Users who have been assigned as reviewers and therefore have correlating status icons for the
review status (Signoff Pending, Approved, and Rejected) are moved to the top of the Team area of
an object. This grouping of team members is then sorted according to signoff status and
alphabetical user name order. The remaining team members who do not have a review assignment
status are sorted alphabetically below.
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Resetting Signoffs

If signoffs on an object are no longer required, or when a new set of signoffs is required, then a user
may choose to reset past signoff indications against that object’s team.

To reset signoffs for an object under review:
1. Go to the Team area of an object.

2. Select the member(s) that has/have a current signoff status indicator that you want reset.
Click s .

4. In the Confirmation window it reads, "You are about to reset the current signoff status for the

selected users. Would you like to continue?" Click = 2%

5. The selected member(s) no longer have any review status icons next to their username(s) in
the Team area.

This process also removes the message at the top of the object alerting a user that he/she needs to
complete a review. However, if the user already completed and action that information will still
display.

Receiving Notifications

Notifications are sent to users when the following actions occur in CNM:

@ User is notified when he/she is added as a team member for an object

o User who authored a note on an object is notified when a comment is added following that
existing note

o User who is assigned as a reviewer of an object is notified when the assignment is given

@ User who assigned reviews is notified when the reviews are completed by each user

Performing More QObject Actions

There is a More Actions dropdown menu found in the top right corner of the page as a user is
working in an object. The More Actions menu has the following available:

o Add to Favorites

o Save As
o Delete

o Send

o Export

o History

o Where Used
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Save As

The option to Save As is enabled only for users with a Participant role or higher. Save As creates a
new object of the same object type, but with a new object number. All of the object attributes are
copied over to the newly created object including tags, Rich text content and attachments.
References, notes, comments, team, and history are not copied over to the newly created object.

To create an object using Save As:

1. Open an object.

. . Save Az
2. Go to the More Actions menu and click

3. Inthe Save As window enter text into the Name field and any desired content into the Description
field.

4. To add a team to the object click il . You can also type in usernames or user group

names and CNM will prompt you with existing user names to add.
5. Inthe Add Team window choose to search for a user or user group.
6. Enter the criteria for your search in the text field and click E.

7. From the search results select the member(s) you want and click .

8. In the Save As window click 2% to finish.

If you do not select any team members to add to your newly created object, CNM automatically
adds you, the creator, as the default team member. Any other teams you want on the object need to
be specially selected during the Save As process.

Users can access a hyperlink to navigate to either the source or target object of a Save As
operation within the History table. Clicking the hyperlink opens a new tab with the object content.
For more information, see History on page 44.
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Replicating Structure with Save As

In the Save As window there is an essential component for objects that have any child objects. You
will find a Replicate structure checkbox as seen below:

Save As (=]
Number [DEADZ2330
Type ldea
* Name
Description
Team Add
v Replicate structure
Help Save Cancel

This checkbox is marked by default for all objects being created using an original template object
with an existing structure of child objects. If you uncheck the box then you simply create a new
object with your set criteria that has no child objects associated with it.

The replicate structure function performs the same Save As process for each child object of the
parent object and maintains the hierarchy levels and dependencies already existent on the original
template object. To illustrate this behavior, see the example below.

Create an object QuoteX with a child object ReqY, which also has a child object IdeaZ.

B QuoteX

..................

..................

Next, perform a Save As for the parent idea object QuoteX and leave the Replicate structure
checkbox selected. Rename the quote to QuoteA. The structure of that quote is now shown in the
Explorer area as this:

B ' Quotea
= =] ReqY
@ ldeaz

The result is a new object hierarchy that has a structure identical to the original object’s, but is
composed of entirely new objects. If you open the ReqY and the IdeaZ objects on the QuoteA
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structure, those objects have the same attributes as the originals, but have new object IDs.
Deleting an Qhject

Deleting an object permanently removes the object from CNM. There is no ability to restore deleted
objects. However, if an object is currently associated with an object structure, either as a parent or
child object, it cannot be deleted. Also, if an object has an attachment or reference then you cannot
delete the object.

To delete an object:

1. Open an object.

) Delete
Go to the More Actions menu and click

3. You are asked, "You are about to delete the current object. Once the object is deleted, it
cannot be recovered. Do you want to continue?"

4. Click 9K  to confirm and finish.
Sending an Chject

Users in CNM can send objects to one another if in Administration the mail server is configured
properly. For more information, see Establishing System Settings on page 72. The Send operation
initiates a notification email to be sent to a user that provides information about that object and any
comments the user includes while sending the object. This utility is an excellent way to initiate
collaboration surrounding objects and their various changes. If you perform any actions to an object
and want other users to know about it, you can send the object with the pertinent information within
the Notes section.

To send an object:

1. Open an object.

2. Go to the More Actions menu and click send...

3. Inthe Send Object window click Add... to search for a user(s) or user group(s) to include in

the Recipient field. Multiple users or user groups can be included if separated by a semicolon (;).
You can also type in usernames or user group names and CNM will prompt you with existing
user names to add.

4. Enter any desired text in to the Notes field and click Send 1o finish.

If any of the recipients are not already part of the team of the object being sent, you are prompted at
that time to possibly add them to the team of the object.
When you receive a notification it will provide the following information:

* Name and email of who sent the object notification;

* List of all the recipients;

* Subject of the natification, which includes the object type and object number;
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* Body of the message with additional details;
* Notes entered by the user sending the object

* An active link directing you to the application Login page and then to the open object

Export

CNM's Export feature supports the following operation:

Export an individual object, or an object with structure from object structures to a Microsoft

Excel or aXML file

Export from search results to a Microsoft Excel file

For detailed information about the Export operation please see the chapter on Exporting and
Importing Objects on page 47.

History

The History of an object records the following actions or events:

a

a

a

Add Attachment
Add Component
Add Reference

Add Team Member
Add URL

Approve

Create

Create Comment
Create Note

Delete Comment
Delete Note

Delete Object
Export

Modify

Modify Reference
Reject

Remove Attachment
Remove Component

Remove Reference
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o Remove Team Member

o Remove URL

o Request For Review

@ Reset Signoff

o Save As
o Send
o Signoff

In the History log you see:

History
View Action m
Action Wodified By Detailz Date Modified
* View — to adjust the column layout
® Action — a dropdown list of actions, from the list found above, used as a filter for the History
log

® Action — the action performed by a user to the object
* Modified By — username of the user who performed the action
* Details — the action taken along with the affected areas of the object
* Date Modified — the date and time of the action

Note By default, all History logs are sorted by Date Modified in a descending order, having the

most recent activity at the top.

To access the History information of an object:

1. Open an object.

2. Go to the More Actions menu and click

History

3. The History window appears and has a table displaying details about the past actions and
events regarding the currently open object.

4. You can then sort the results by column headers, use View or filter using the Action dropdown.

5. When finished click = “2%% |

For an object created by a Save As action, the History window has a hyperlink directing the user
back to the original object. Conversely, an object that was used for a Save As action has a hyperlink
within its History window directing the user to the newly created object.
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Where Used

To access the Where Used information about an object:

1. Open an object.

i , Where Used
2. Go to the More Actions menu and click HHhere Uee

3. Inthe Where Used window, a table displays the object that is the parent of the currently open
object.

4. The Name and Number are active links, which take you directly to that parent object's Summary
page.

Note Like the search results restrictions, if you do not have access to an object because you
are not a team member, the object does not appear in the Where Used table.
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Exporting and Importing Objects

This chapter includes the following:

B OVBIVIBW ..ottt s8££ R bR

= Supported Operations and File Formats

= Exporting ObJECtS fTOmM CNIM .........cuiiiiiii bbb

= IMporting OBJECES INT0 CNIM ..o
Overview

CNM's Export and Import features support the following operations:

o Export an individual object, or an object with structure from object structures to a Microsoft
Excel or aXML file

o Export from search results to a Microsoft Excel file
o Import to update existing objects in the system (CNM server) in the Microsoft Excel format

o Create objects by using the Import process to import directly from Microsoft Excel worksheets

Using these features, you can update existing objects such as Quotes with data provided by one or
more users, or import externally prepared worksheets for use in the CNM application. For example,
there is usually a need to update costs for existing objects, or create costs for new ones. A
convenient option is to export existing data (Quote) pertaining to the object to Excel, update it in the
Excel format, and then import it back into the CNM application. Or, if there is an externally prepared
Excel worksheet with applicable data, you can import the data and use it as a CNM object.

The supported file formats, along with the necessary procedures, constraints, and examples to
perform these tasks appear in this chapter.

Supported Operations and FHle Formats

o Export supports Microsoft Excel and aXML formats as follows:

*  Excel worksheets — You can export single or multilevel structures, including those from
search results to an Excel worksheet

* aXML files — You can export Attachments (files, URLs, and References to Agile PLM
objects) plus Comments, and Where Used and Structure information from CNM to aXML
files.

o Import only supports the Excel format. You can import a plain list of objects from the following
sources into the system:

* An Excel worksheet from a third-party system as a flat structure
* Exported objects from the object’s tree and search results as a flat list of objects from an
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Excel worksheet

Note When importing objects, Comments, Attachments, References, and Structure
information are not imported and the "Level" column created during the Export
process is not imported.

Exporting Objects from CNM

You can export from:
o Object structures to Microsoft Excel worksheets
o Object structures to aXML files

o Search results to Microsoft Excel worksheets

Exporting to Microsoft Excel

Exporting to Microsoft Excel from Object Structures or from Search Results prepares a
spreadsheet. However, the Level column is not exported if you are exporting from Search Results
or from Object Structures and you have selected the Root Only option.

Note When exporting to Microsoft Excel, only the Cover Page fields (out-of-the-box and
flex fields that are enabled) are exported. Attachments, Notes, and Comments are
not exported.

Exporting from Object Structures

Exporting from Object Structures prepares a Microsoft Excel spreadsheet with the following
formation:

o Objects are listed in the sequence in which they appear in the structure tree

o A“Level field in the first column indicates the hierarchy of the structure, with "0" indicating root
or the object that is exported, and subsequent increments of "1", "2", ... "n" representing the 1%,
2" ..., and n" level respectively

o All object attributes such as Number, Description, Created By, and so on are exported in columns
and under column headings pertaining to the attribute type

To export objects to Microsoft Excel:

1. Loginto CNM and create an Idea object called Modern Sailboat and a child Quote object
Quote for Modern Sailboat.

Note The Idea object called Modern Sailboat and the Quote object, Quote for Modern
Sailboat, are created as examples to help document exporting from object
structures. You can open and export an existing object structure as in this example,
or create and export a new object structure. If the object was already added to
Favorites, you can also use Favorites for finding and opening the object that you want
to export. See Exporting to aXML Files.
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2. Inthe More Actions dropdown list, select Export.

ORACLE" Agile Customer Needs Management Welcome Admin Ch
Create Favories  Recents  Tools search |G|
Home Browse Modern Sailboat
Explorer Modern Sailboat
* X B @ o summary

‘ i Modern Sailboat 5 Pending

Quote for Modern Saily
More Details

= Attachments & References
There is no data to display.

= Hotes

s

The Export window opens and prompts you to select your choice of Export Format and Export
Level. The Include Attachments option in not available because export to Excel is selected.

3. In Export Format, select Excel, in Export Level, select All Levels, and then press Export.

'E)(port |§|

Export Format IExceI 'I

Export Level

Al Levels

Include [yg =

Attachments
Help Export Close
Note In Export Level, you have the option to select Root Only, Level One, or All Levels.

Selecting Root Only will export the Root object, which in this case is the Idea object.
Selecting Level One, will export the next level, which in this case is the Quote object.
Selecting All Levels, will export the Idea, Quote, and applicable levels to Excel.
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4. A window prompts you to open or save the file. You can save the file for modification in Excel

and for subsequent import it into CNM.

File Download x|

Do you want to open or save this file?

@ j Mame: IDEAODDLO03.xls
LH]

Type: Microsaoft Office Excel 97-2003 Worksheet
From: scl34037.us.0racle.com

Open Save | Cancel I

|--"‘~] While files from the Intemet can be uzeful, zome files can potentially
a harm vour computer. IF you do nat trust the source, do naot open or
= zave thiz file. What's the rigk?

Level IMame Description  Tags Object Mumber  Type:ldea Status Date Created Da
Level MName Description  Tags Object Mumber Type:Quote  Status Date Created Da
0 Modern Sailboat boat IDEADO103 Idea Pending 2/2472011 19:32
i Quote for Modern Sailboat QUOTEDD002  Quote Pending 272472011 20:31

Note You can see the "Level" column mentioned in Supported Operations and File
Formats on page 47 in Column A. When you import this file into the system, this
column is not imported.

Exporting from Search Results

This process prepares a worksheet as follows:

o

o

Search Results are only exported to Microsoft Excel
Level is not exported when exporting from Search Results

If no rows are selected in the Search Results table, Export will export all rows, but if one or
more rows are selected, Export will only export the selected rows

No export window is launched during the export process

If objects in search results have a structure, Export from search results will only export the root
object

Exported objects are not listed in the same sequence in which they appear in the Search
Results table

To export from Search Results:

1.

Log in to CNM and in the Browse tab run a search for the object Modern Sailboat.
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Search results display in a Search Results table, as seen below. You can select any object in the
table for export. See Searching in CNM on page 10.

Home Browse

EAdvanced Search
Match & Al € Any

Type IEquaItu L” LI Tag Im
Name/Number/Desc W Modern Sailboat Rich Text Im
name [contans ¥ Date Created [Equalto =] £
Description Im Date Modified m EEB
Number lm Created By lm

Search Reset

El Search Result

e 8 55

Al - Al &y [y
Name Number Type Description Status. Tag Created By Date Created Date Modified
“g"Modern Saiboat |IDEA0D103 idea Pending boat Admin CM (admin) | 02/24/2011 07:32:4..] 02124/2011 08:31:57 PM PST
T Quote for Mode...| QUOTEDODO2 |quote | |Penaing | |Aamn crat aominy  [o2r2ar2011 08:31:5.. 0212412011 08:31:57 PM PST

2. Inthe Search Results table, select the idea object named Modern Sailboat and then click the
Export |@ | button.

Similar to Exporting from Object Structures, a window appears and prompts you to open or
save the Excel file. Although this object has a multi-level structure, only the Root object is
exported and the data displayed in this Excel worksheet does not include the Level column that
appeared in Exporting from Object Structures. Also, although only a few fields are displayed in
the Search Results table, the exported Excel file contains all the Cover Page fields (out-of-the-
box and enabled flex fields).

Mame _|Descripti0n Tags Object Mumber Type:ldea Status  Date Created Date Modified Created By Modified By
Maodern Sailboat boat IDEAD0103 Idea Pending 2/24/2011 19:32 2/24/2011 20:31 Admin CNM Admin CNM

Exporting to aXML files

The following procedure assumes a multi-level Object Structure is already created and added to
Favorites. It locates and opens the object and exports the entire structure (Notes, Comments, and
Attachments and References) to an aXML file.

To export object to aXML files:

1. In CNM Explorer, select Favorites > Proposal for Magnetic Field in... to locate and open the object.

Recents Toolk:

Manags Favorites...

E& Launch
.2 Propozal for Magnetic Field In...

Note The selected object has References, URLs, Notes and Comments.
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4.

5.

In the More Actions dropdown list, select Export. The Export window opens.

Export (%]

Export Format | gumL »
Export Level | allLevels

Include Atachments yes | v

Help Export Close

In Export window's Export Format, Export Level, and Include Attachments, select the aXML, All Levels,
and Yes options respectively, and then press Export.

The object along with its References, URLS, Notes, Comments, and Where Used information is
exported in a .ZIP file and the browser gives you the option to save or open the .ZIP file.

File Download x|

Do you want to open or save this file?

E Mame: QUOTEDNOD4, zip
Type: zip Archive

From: scl34037 .us.oracle.com

Open Save | Cancel I

harm pour computer. |f you do not trust the source, do not open or

l--"y‘» Wwhile files from the Internet can be uzeful, zome files can potentially
N zave this file. What's the rigk?

Save and then extract the contents of the .ZIP file.
The aXML file and attachments (files) are included in the .ZIP file.
Open the aXML file.
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Information related to the object such as References, URLS, Notes, Comments, and updates
appear in the aXML file.

<?xml version="1.0" encoding="UTF-8§" ?>
- <Objects xmlns="http:/ /www.oracle.com/technology/products/applications/xml/plm/2011/04/" xmins:xsi="http: / /www.w3.0org/ 2001 /XMLSchema-ins
wmins:xsd="http:/ /www.w3.0rg/2001/XMLSchema" xsi:schemalocation="http:/ /www.oracle.com/technology/products/applications/xml/plm/2011/0
http:/ /www.oracle.com/technology/products/applications /xml/plm/2011/04/acnm.xsd"=
- <Object type="Quote">
- <Attributes=>
<ShortDesc =Proposal for Magnetic Field in...</ShortDesc>
<Tags>magnet</Tags>
<IdeaNumber=QUOTEOD004</IdeaNumbers
=Type=Quote</Type:>
<Status=Pending</Status=>
<DateCreated>=2011-02-24T20:59:49-0800</DateCreated>
<DateModified>2011-02-24T21:03:55-0800</DateModified=
<CreatedBy =Admin CNM</CreatedBy >
<ModifiedBy >Admin CNM </ModifiedBy >
</Attributes =
- =Reference:=
- <Row >
<Fulfillment=0</Fulfilment>
<ObjectkKey=>2_-1_10000_6099226 </Objectkey =
<Fileld=0</Fileld=
<DateModified>2011-02-24T21:01:38-0800 </DateModified =
<ModifiedBy =Admin CNM</ModifiedBy =
<Sourceld>2</Sourceld=
<RefDesc=Grace 10/25 - - new database on scl34060 demo931o0as, demo931rmwowner, demo931rmwuser - add attachment and view work fine-
<RefNumber>P00001 </RefNumber>
<Parentld>10294 </Parentld=
<Refld>10307 </Refld=
<Type=Item</Type:=
</Row =
- <Row >
<Fulfillment=0</Fulfilment>
<Objectkey=http:/ /www.bestever.com</Objectkey>
<Fileld=0</Fileld=
<DateModified>2011-02-24T21:00:25-0800 </DateModified =
<ModifiedBy =Admin CNM</ModifiedBy =
<Sourceld>-1</Sourceld=
<RefNumber=http:/ /www.bestever.com</RefNumber >
<Parentld>10294 </Parentld=>
<Refld>10300</Refld>
<Type>=URL</Type:
</Row =

Importing Objects into CNM

As mentioned in Supported Operations and File Formats on page 47, in addition to importing
exported objects, you can also import a number of objects directly into CNM from Microsoft Excel
worksheets.

Information provided in the following paragraphs lists the importable and modifiable attributes and
those that are neither importable/modifiable and shows how to:

o Modify and import an exported CNM object

o Import objects that do not exist in the system from an Microsoft Excel worksheet

Modifying Attribute Values

You can modify and update values for all attributes except for the read-only (system) attributes.

You cannot update the following fields using Import:

vl 53



Customer Needs Management Guide

o Object Number
o Type

@ Owner

@ Date Created

@ Date Modified
o Created By

o Modified By

You can import values for attributes that are not system attributes and are enabled and modifiable
for the specific object type. Make sure column headings are worded exactly as they appear in CNM,
and a column identifying type is present. In these instances, Oracle recommends using a sample
output file as a template. Other out-of-the-box fields on Cover Page and enabled flex fields can be
updated using the Import process. When importing Date fields, the required format for the entry is
the following: MM/DD/YYYY.

Importing Modified Chjects

The following Import procedure creates and locates an object that has its Idea, Requirement, and
Quote components. The object is exported to Excel and after some modifications it is imported and
viewed in CNM.

Important If you plan to import a modified exported object, Oracle recommends enabling the
necessary attributes and creating the Idea, Requirement, Quote types in CNM prior to
export. This preparatory task will simplify updating the applicable attributes in the
Excel workshop.

Create, update, and import a Requirement Type object for an exported Idea object:

1. In CNM, create the following Requirement object for the Modern Sailboat Idea exported in
Exporting to Excel Workshops.

Saye Cancel

| Reguirement

Reefing main and jik

ElMore Details

408 | boat Estimated | 7000

Cost:

Object REQO1ETS

Number I L

Complete:

Type: Requirement - .

' . Special |In Boom Reefing

Status: | pending  |[w Comments:

S_— % _ Date 16-Jan-2010 01:44 PIf
Completion Lreated:
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2. In CNM, select and export the Requirement for this object and then open the file in Excel.
A B C D E F G H \ J K L M | 0 P Q
1 Neme  DescrptiorTags  Object NurTypeRequStatus  Target Cor Mandator Ouwner  Requirsme Estimated % Comple: Special Ce Date Creat Date Madi Created By Modified By
2 |RequiremeResfing méboat ~ REQQ167€Requireme Pending Oter 000 T In Boom R 16-Jan-20106-Feb-20- Admin CNIAdmin CHM
3. Modify the attributes as shown in the bold font faces.
A B C ] E F G d | J K L M N 0 P Q
1 MName  DescriptiorTags  Object NurType:Requ Status — Target Compl Mandato Owner Requirsme Estimated % Comple Special CeDate Creat Date Modil Created By Modified By
2 |RequiremeReefing mcboat ~ REQO167¢Requireme Pending ~ 310/2010 Other 7500 25 In Boom R 16-Jan-20108-Feb-20" Admin CHIV Admin CHI
4. In CNM, select Tools > Import.
Import
* Import File I Browse...
Help Import Cancel
The Import window displaying status, the number of lines and attributes, and any errors it
encountered during the Import process appears. If you press the Back button, the window
reverts to the one shown in Step 4 above, enabling you to re-import, or import another
workshop. As indicated earlier, Import will lose the Level attribute. This is not applicable here
because the object you are importing is a flat structure.
Import
Impert Status: Complete
Import lines completed: 1
Import lines =kipped: 0
Requirement attribute Object Number iz read only
Reguirement attribute Date Created iz read only
Req ent attribute Date Medified iz read only
Req ent attricute Created By is read only
Requirement attribute Medified By is read only
Back Cloze
5. In CNM, use object number (REQ01676) to locate the updated object.
[l Search Result
o 8 5B
All - All
Name Number Type Dezcription Status Tag Created By Date Created
@Raquirement REQO000A1 Requirement Reefing main and jib |Pending boat Admin CNK {admin} 02/24/2011 09:5
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6. In CNM, open the object and note the attributes you updated in Excel (Estimated Cost, %
Complete, and Target Completion Date).

Requirement [Pending]

Reefing main and jit

=l More Details

Tags: boat 7500
Object Number: REQO1675 25
Type: Reguirsment Special Commentz: In Boom Reefing
Status: Pending Date Created: 18-Jan-Z2010 01:44 PK
Target Completion Date:  10-Mar-2010 12:00 AN Date Modified: 08-Fsb-2010 03:1% PM
Mandatory: Created By: Admin CNIK
ownesr: Modified By: Admin CNI

Importing Directly from Excel Worksheets

This feature of the Import process enables creating objects that do not exist in the system. The
required access levels, mandatory and optional attributes, and the necessary procedures appear in
this section.

Required Access Level (Privileges)

Because importing objects directly into the system creates new objects, only users with a
“Participant” or higher role can perform this operation. This is the same access level required for
users of the Create function.

Required Attribute Values

To import data directly from a Microsoft Excel worksheet, you must specify values for the following
attributes. Otherwise, the object is not imported

o Object Type

o Object Name

o Object Status

Note Because the Import process creates a hew object for each row of the Excel
worksheet, it is necessary to provide these values for each row of the Excel
worksheet. See Examples

Optional Attribute Values

When creating objects using Import, you can assign values to any enabled and modifiable field,
such as the Description field. Do not specify a value for the Object Number attribute. The Object Number
value is specified only if you are trying to update an existing object where specifying the Object
Number value is mandatory. CNM's Import process assigns values for the Object Number attribute for
each imported object.
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Note To facilitate locating objects created using Import in CNM, use values specified in
the Excel file for attributes such as Tag, Name, or other modifiable fields as search

keys.

Examples

The following example describes the process from the initial creation of the Excel worksheet
through specifying the mandatory attribute values, creating objects using Import, and searching and
viewing the imported objects in CNM. The example assumes one of the modifiable fields called

Value is enabled for the Idea object.

Important Depending on the type of objects that you want to import, you must include different
number of object header rows. For example, if the import file contains the Idea and
Quote object types, then you must add two header rows with the corresponding field
names for Idea and Quote objects. The example below is adding the Requirement

type also.

To create the worksheet and set the mandatory attributes:

1. In an Excel worksheet, do as follows:

* Type the values shown in rows 1 - 6 of columns A and B to assign the mandatory values
respectively. Set the values shown in the columns C, D, E, and F of rows 1, 2, and 3 (this

is optional).

®* Inrows 4, 5, and 6 of columns A and B, specify the values shown below for the mandatory
fields. Set the values shown in the remaining columns C, D, E, and F of rows 4, 5, and 6

(this is optional).

A B C
1 Type:ldea Name Description
2 |Type:Reguirement Name Description
3 |Type:Quote Name Description
4 |ldea Build a boat Multihull racer
5 |Requirement Speed 20 Knots
6 |Quote Sstimate S5000K

D
Status
Status
Status

Pending
Pending
Pending

E

Tags
Tags
Tags
Boat
Boat
Boat

Value

Gold Medal

2. In CNM, select Tools > Import > Browse to open the worksheet.

Import

*Import Fiie | C-\Documents and Seftings\ftabibza

Help Import

Cancel

3. In Import dialog, select Import.
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The Import dialog displays the import status. Assigned values for the three rows are imported.

Import

Impiort Status: Complete
Import lines completed: 3
Import lines skipped: 0

Ohject type value iz empty.

Close

In CNM, use Idea object's Name or Description to locate the imported object.

Note In addition to the mandatory attributes, optional values such as Tags, Status, and
"Gold Medal" which was set for the enabled attribute called Value is also imported.

= Summary /

Biuild & boat

MUItibL FacEr
= More Details
Tags:
Ohject Mumber,
Type
Status:

Aprover

boak
IDEADDGSZ
Ides

Pending

[Pending]

List01:

Tt (ldea):
Walue:

Diate Createcd:
Date Modified:
Criated By
Modified By

Gold Medal
16-Feh-2010 03:52 PM
16-Feb-2010 03:52 Ph
Acdmin Chihd

Acdmin Chibd
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Administration

This Appendix includes the following:

B CONM ADMINISITALON ..ottt bbbt 59
5 ObJECtS AN AHHDULES ....vuivvicecice e b bbbt 60
1 OO 64
L U Y3 66
B USEI GIOUDS ..vuvueeesetciei ettt ettt bbb 68
T (o (0 ] o TP PP 70
B SYSIEM SBHINGS ..vcviiecteicct ettt bbbt bbbt b bbbt b n s 72

CNM Administration

This Customer Needs Management (CNM) Administration section is the primary resource for CNM
administrators. There is information regarding defining CNM objects and their attributes, setting up
users and user groups, and establishing system settings for CNM.

Administrative Capabilities

Administrators can customize the behavior of each object type using the configurable options
provided for each object type. There is a specific process to create users in CNM. For more
information, see the CNM Implementation Guide. Once a user is created that has the Administrator
role, more users can be created by accessing the Administration section.

After successfully logging in as an administrator user, access the Administration section by clicking

sl CUll i the top right corner of the Home Page. You are directed to the Administration section

that has the following:

o Objects and Attributes — define and manage object types, attributes, and properties

o Lists — define and manage list values

o Users — create, modify, and disable users

o User Groups — create, modify, and delete user groups

o Keyword Library — create and view keywords that associate CNM objects to one another

o System Settings — configure and establish system settings that impact search, attachments,
sending objects, references, and more

vl 59



Customer Needs Management Guide

Important Agile CNM supports seven languages in addition to English. If the administrator
makes a change in one language, that change needs to be performed in the other
languages as well to ensure that across all language preferences for users there is a
reflection of the same system changes. After any change is made, all administrators

need to login with other language preferences and make the necessary corresponding
changes.

Cbjects and Attributes

From Objects and Attributes, you can define and manage object types along with their properties and
attributes. Each object type can have a different set of attributes. Specific attributes are common to
all object types while others can be modified, enabled, configured, or removed.

Important You cannot delete a default, pre-defined object type. You can only adjust and change
the properties and attributes of the object type to reflect what you require.

The following table lists the default object types in CNM:

Object Type Prefix Description
Quote QUOTE A vendor's statement of products and
services offered to a potential customer
Idea IDEA A suggestion for a product, process, or
service
Requirement REQ A set of conditions or necessary

specifications for a product

Adjust these object type definitions as needed for your desired business processes and
nomenclature.

Defining Properties

All of the available properties of an object are editable. You can configure any object type to help
accommodate your business process needs. The following table contains the configurable object
type properties:

Object Property | Data Type Property Values Description

Name Text Idea, Quote, or Requirement The configurable object types for CNM
Description Text TBD A text string the administrator enters

Enabled List Yes or No Allows or limits the user creating and searching

for specific object types in CNM. If set to No,
the associated object type cannot be searched
for or created. This includes quick searches,
advanced searches, adding by search from
Explorer, and Tag cloud searches.
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Default Team

List

TBD

User groups that are assigned to an object type
and are therefore automatically assigned as
team members for any object created that is of
that object type

Prefix

Text

TBD

A text string the administrator enters that
becomes the prefix for the object number

autogenerated by CNM

The required fields, which may not be left blank, are designated by an (*) before the field name.
Editing Object Properties

To edit the properties of an object type:

1. From Objects and Attributes click the Object Type dropdown menu to choose which object type you

want to edit.

2. Once you have selected the object type click 9t on the Properties tab.

3. Now all the available fields are in edit mode and you can change the fields to the values you
want.

4. Click Save when you are finished.

(oject Attributes

The following are the various data types for attributes:
o Text — contains any valid character from the keyboard

Note The Display Height property determines if the text attribute is a single line text field or
a multi-line text field. For more information, see Attribute Properties on page 63.

o Number — contains positive or negative numbers, the decimal (.), comma (,) and the hyphen to
indicate a negative number (-) value

o List— contain values the administrator configures or sets as default values for such attributes

o Date — a date selected from a calendar or entered directly by the user

The default configuration for the attributes of objects is found in the table below:

Attribute Name Display Name Modifiable | Data Type | Visible Description
ID ID No Number No A unique identifier
autogenerated by the CNM
system
ShortDesc Name Yes Text Yes An identity for the object
Description Description Yes Text Yes More information about an
object
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Attribute Name

Display Name

Modifiable

Data Type

Visible

Description

Tags

Tags

Yes

Text

Yes

A keyword identifier to
categorize objects together

IdeaNumber

Object Number

No

Text

Yes

An autogenerated number

Type

Type

Yes

List

Yes

Classifications for each
object type created by the
administrator to accurately
reflect the processes in CNM

Status

Status

Yes

List

Yes

Determined states for
objects that reflect the
progress of the objects
implementation. Default
values are: Pending, Review,
Approved, and Rejected

Owner

Owner

No

Number

No

The user who created the
object

Deleted

Deleted

No

Number

No

ObjVersion

Obj Version

Yes

Number

No

The version number of the
object type

Date01-Date15

TBD

No

Date

No

Administrator determines this
attribute according to the
CNM process needs for the
users

List01-List15

TBD

No

List

No

Administrator determines this
attribute according to the
CNM process needs for the
users

Number01-Number15

TBD

No

Number

No

Administrator determines this
attribute according to the
CNM process needs for the
users

Text01-Text15

TBD

No

Text

No

Administrator determines this
attribute according to the
CNM process needs for the
users

DateCreated

Date Created

No

Date

Yes

The date and time the object
was created

DateModified

Date Modified

Yes

Date

Yes

The date and time the object
was last modified

CreatedBy

Created By

No

List

Yes

The first and last name of the
user that created the object

ModifiedBy

Modified By

Yes

List

Yes

The first and last name of the
user that last modified the
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Attribute Name Display Name Modifiable | Data Type | Visible Description

object

RichText Rich Text Yes Rich Text No Formatted text entered by
the user rendered through

ADF

Important Only fifteen flex attributes for each data type are allowed for each object type.

Editing Object Attributes

To edit the attributes of an object type:

1. From Objects and Attributes go to the Attributes tab.

2. Inthe table display of available attributes click the attribute you want to edit.

3. Below is the Attribute Properties section where you click (B9t and the attribute property fields
become editable.

Save

4. When you are finished click

Attribute Properties
The available properties for attributes are found in the table below:
Property Available on Attributes Data Type

Attribute ID Date, List, Number, Text Number
Attribute Name Date, List, Number, Text Text
Display Name Date, List, Number, Text Text
Description Date, List, Number, Text Text
Visible Date, List, Number, Text List
Modifiable Date, List, Number, Text List
Data Type Date, List, Number, Text Text
Display Type Date, List, Number, Text List
Display Order Date, List, Number, Text Number
Default Value Date, List, Number, Text Text
Help Text Date, List, Number, Text Text
List Name List List
Display Height Text Text

vl

63



Customer Needs Management Guide

Lists

From Lists, you can define and manage list values made available on specific object types. Please
note that when you disable some list values, on attributes assigned to those lists, the disabled
values show up the text (disabled) after the value in the list dropdown. This applies to all lists
including the users list.

List Properties

The following are the properties of lists:

o |D— a unique identifier autogenerated by the CNM system

o Name — field you can edit to reflect the name of the list being created

@ Enabled — dropdown menu of Yes or No options to determine if the created list is enabled
o Description — area available for more details about the created list

o Type — designating the type of list as a Text or Image
Qreating Lists

To create a list:

1. From Administration go to Lists and click .
2. Inthe Properties tab enter a Name for the list you are creating.

Note List names are not case sensitive and must be unique.
3. Set the Enabled field to Yes or No and enter text into the Description field if needed.

4. Click 22 1o finish.

List Values

The List Values tab is where you add list values to an already existing list entry. The Entry ID number
is autogenerated, but you need to enter names for each list value you create and determine if it is
enabled or disabled.

Qreating list values
To create a list value:
1. Go to the List Values tab.

2. Click and enter a name for this list item in the Entry Value field.
3. Set the Enabled field to Yes or No.

4. Click 528
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5. You can click to continue creating entries.

Save

6. Click when you are finished.

Modifying Lists

To modify the properties of a list:
1. From Lists go to the Properties tab and click |EdR
2. Enter in your new values for the Name, Enabled, and Description editable fields.

Save

3. Click to finish.

To modify the list values of alist:
1. From Lists go to the List Values tab.

2. Inthe Entry Value and Enabled columns make any changes needed.

3. If the changes made are incorrect click Reset 1o begin making changes again.
4. Click 5 to finish.
Status List

Each object type has a Status list of values associated with it. This Status list is essential in the
management of the lifecycle of an object within CNM. As an administrator you designate the
number of statuses that are active for each object type, the icon associated with each status, the
name of each status, font color of the status title, the creation of additional statuses or the disabling

of a status that is no longer needed.

To edit Status list properties for a specific object type:
1. Go to Administration > Lists > Status List > Properties tab.
2. Click Edit.

3. Change values for Name, Description, and set the Enabled dropdown to Yes or No. The Type value

is by default an Image.
4. Click Save.

To edit Status list values for a specific object type:

1. Go to Administration > Lists > Status List > List Values tab.

2. You can edit the current values of existing Statuses or click Create.

3. Enter values for the Entry Value and set the Enabled dropdown to Yes or No.
4

Next add an lcon and select a Font Color.
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5. Click Save.

Users

From Users, you can configure the following aspects of users in CNM:

o Create and add new users

o Modify user properties such as email, roles, etc.

o Disable existing users

User Properties
The user object in CNM has the following properties:
Property Modifiable Description
User ID No The user's sign on name. This property is required to be unique for each user.
Note If your CNM system is integrated with an Agile PLM system, the PLM system
validates the User ID (username) so do not change your CNM User ID
(username).
Status Yes A dropdown list with these two options: Enabled or Disabled
First Name Yes A text field to enter in a user's first name
Last Name Yes A text field to enter in a user's last name
Email Yes A text field to enter in a user's email address
Role Yes A dropdown list with the following default options: Viewer, Participant or Administrator
Note If you have configured the Roles to different names, those will appear as the
options for the user properties
Number Yes A dropdown list providing formats for the display of your numbers
Format
Time Format Yes A dropdown list providing formats for the display of your current time in Hours, Minutes
and Seconds
Time Zone Yes A dropdown list providing global selections for your current time zone
Date Format Yes A dropdown list providing formats for the display of your current time date in Years,

Months and Days
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Property Modifiable Description

Language Yes A dropdown list with the following default options:

English, French, German, Japanese, Korean, Russian, Simplified Chinese and
Traditional Chinese

User Roles
User roles provide a level of security in CNM. The role assigned to a user determines the actions
that the user can carry out on accessible objects.

Viewer — can only perform View, Approve, Reject, Add Notes, Add Comments, Send, View
History, View Where Used, and Add to Favorites actions on the objects that he/she has
access to.

Participant — can perform all object transaction actions such as Create, Delete, Modify, Save
As, Send, Comment, Tag, Import, Export, along with all the actions available to the Viewer
role on the objects that he/she has access to. A Participant does not have access to any of
the Administrator features.

Administrator — can perform all the object actions available in the product that he/she has
access to. The Administrator can also perform all the actions defined in the Administration
section such as defining object attributes, adding lists, creating users and user groups, and
establishing system settings.

Adding a User

Once you have gathered information about new users and assessed their access requirements, add
them to the CNM system. The User ID needs to be unique, and if the administrator chooses an
already existing User ID the system will notify the administrator with an error message.

To create a new user:

1. From Administration choose Users.

Click to open the Create User window.
Type the Username, First Name, and Last Name in the required fields.
Enter a value for the optional field Email.

Choose Viewer, Participant, or Administrator from the dropdown list of available roles.

o gk~ w DN

Click Create. The Settings tab of the newly created user appears in the bottom pane of the
workspace already in Edit mode.

7. You can then adjust the editable fields of Status, First Name, Last Name, Email, and Role.

Note The User ID is an uneditable field.

8. Click '€ 1o finish.
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Editing a User's Properties

To edit a user's properties:
1. From Administration choose Users.
2. Click the User ID of the user you want to edit.

From the Properties tab of the user click ﬂ

w

4. You can then adjust the editable fields of Status, First Name, Last Name, Email, and Role.

Note The User ID is an uneditable field.

5. Click '€ to finish.

Disabling a User

To disable a user:

1. From Administration choose Users.

2. Click the User ID of the user you want to disable.
From the Properties tab of the user click |EdR,

4. Change the Status field from Enabled to Disabled.

5. Click Save to confirm and finish.

When a user is disabled they no longer have access to the CNM application. The team membership
that they have associated to their user is still valid, but if another user is searching for users to add
to a team, to send an object to, or to make part of a user group, CNM does not display the disabled
users in the search results.

If you disable a user that is a member of any user group, CNM noatifies you that the user groups the
user is a member of are removed from that user. However, when you re-enable the user, CNM
notifies you that the user groups previously associated with the user return to the user and he/she is
once again part of the user group membership.

User Groups

From User Groups, you can configure the following aspects of user groups in CNM:
o Create and add new user groups
@ Modify user group properties such as name, description, members, etc.

o Delete existing user groups

User Group Properties

The properties of a user group are Name and Description. A name is required and both are editable.
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Members

The Members tab of a user group is where you can search for existing CNM users and add them to a
user group.

Adding a User Group

To create a new user group:

1. From Administration choose User Groups.

2. Click . The Create User Group window opens.
Enter values for Name and Description.
4. Click Create to finish.

To add members to a user group:

1. Go to the Members tab of the newly created user group found in the bottom pane of the
workspace.

To find users to add to the user group click % .

3.  From the Add Members window search for existing users.
4. Once you have selected the desired user(s) click A9 1 finish.

Editing a User Group's Properties

To edit a user group's properties:
1. From Administration choose User Groups.
2. Click the name of the user group you want to edit.
From the Properties tab of the user group click |EdR
4. You can then adjust the editable fields of Name and Description.

5. When you are finished with your changes click Save

Deleting a User Group

To delete a user group:
1. From Administration choose User Groups.

2. Click the name of the user group you want to delete.

3. Click X . There is a prompt asking you, "Do you want to delete the selected user group?"

4. Click 9K to confirm the deletion.

Once a user group is deleted, the group is also removed as a team for any object that has it
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assigned as a team member.

Keyword Library

From the Keyword Library the administrator can create and view keywords that correlate objects to
one another in CNM.

Keyword Entry and Removal

To create a keyword:
1. Go to Administration > Keyword Library.
2. Click Create.

3. Inthe Create New Keyword(s) window enter text for the name(s) you want to create, up to 150
characters. You can enter more than one keyword at a time by clicking Enter on your keyboard
to separate entries.

Note Any duplicates entered are ignored by CNM. Keywords are displayed how the user
entered them, but they are treated as case insensitive.

4. When finished, click 2

To delete a keyword:
1. Go to Administration > Keyword Library.
2. Find the existing keyword you want to remove and click the

3. Inthe Confirmation window it reads, "Do you want to delete the selected keyword?"

4. Click 9K to finish.

Keyword Generation

The following areas are used to generate keywords for an object when there are no predefined
keywords entered by an administrator in the Keyword Library:

o All the words in the object Name
o All the tags associated with the object

o All the words from Description, if the description is less than 10 words

If there are predefined keywords entered by an administrator in the Keyword Library, then in addition
to the above mentioned three areas, all the words from the following areas are tallied against the
keywords in the Keyword Library:

o Object Name
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o Tags
o Description
o All text, rich text and list flex fields

o Notes and Comments

All the matches will be added to the keywords for an object. This process is illustrated in the
diagram below.

[ Description J

/ Long Description (more
than 10 words)

Administrator
predefined
Keywords List

J

Consolidation of all Name, Tags, Description, flex text/list fields, Rich Text,
Notes and Comments.

[ Title/Name

Note Stopwords are excluded from the keyword list and similar object search analysis. For a
list of stopwords as defined by Oracle, see
http://download.oracle.com/docs/cd/B28359 01/text.111/b28304/astopsup.htm#CE
GBGCDF
http://download.oracle.com/docs/cd/B28359_01/text.111/b28304/astopsup.htm#CEGBG
CDF.

Once the keywords of an object are generated, the set of keywords is used to run a Full Text
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Search across all the objects in the system. The Full Text Search returns the matching score for all
the objects in CNM. The top five objects with the highest percentages of association display in the
See Also... section of that current object. For more information see Leveraging the See Also....

System Settings

From System Settings, you can modify the previously configured CNM system settings. If you begin

entering changes that you do not want to keep, click Re=2t 6 remove all the unsaved changes for

each setting. Any changes made to the system settings go into effect for users who log in after
those changes have been applied by the Administrator, and therefore do not reflect in any user
sessions that are concurrently running while the changes are made. In order to see changes made
by the Administrator, users should log out from their current session and log back in.

It is strongly recommended that you restart your application server after making and
saving changes to the System Settings of CNM in order for all the changes to be
implemented.

Important

Establishing System Settings

The following fields are configured for your CNM system settings after installation:

Name Description Modifiable Values

Schema Version Schema Version No 1.1.0.xx

Authentication Authentication Provider No Agile PLM or LDAP

Provider

Mail Server Mail Server Yes http://mail.your-company-name.com

Mail Server Port Mail Server Port Yes 25

Web Client URL Web Client URL Yes http://cnm-link:port/acnm

Search in Attachment Search in Attachment Yes Yes or No

*Viewer URL Viewer URL Yes http://ucm-web-
client:port/virtual/path/idc/jsp/autovue/
csiApplet.jsp

*UCM Administrator UCM Administrator Yes XXXX

*UCM Administrator UCM Administrator Yes i

Password Password

CNM Home Directory CNM Home Directory Yes X\xxxx\yyyy\zzzz

Online Help URL Online Help URL Yes http://<upkhost>/agilecnm/hemi/agilec
nm_gateway.html

File Server Type File Server Type No Agile PLM File Server or UCM

72

Agile Product Lifecycle Management



http://mail.your-company-name.com/
http://cnm-link:port/acnm
http://ucm-web-client:port/virtual/path/idc/jsp/autovue/csiApplet.jsp
http://ucm-web-client:port/virtual/path/idc/jsp/autovue/csiApplet.jsp
http://ucm-web-client:port/virtual/path/idc/jsp/autovue/csiApplet.jsp

Appendix A

Name Description Modifiable Values

File Folder Subclass File Folder Subclass Yes Dropdown menu of currently enabled
file folder subclass types available in
Agile PLM

Agile PLM Server URL | Agile PLM Server URL No http://your-agile-plm-
server:port/virtual-path

Agile PLM SSO Agile PLM SSO Server Yes http://your-agile-plm-SSO-

Server URL URL server:port/virtual-path/PLMServiet

Note The fields with an asterisk (*) above are not required and these fields will be uneditable
when the File Server Type is set to Agile PLM because these options are valid only when
the file server type is set to UCM file server.

All of the fields above will have default values, according to prior configuration, once CNM is
properly installed. For more information, see CNM Implementation Guide.

Some significant CNM behaviors are determined by the values of these system settings.

The Mail Server value determines what server host is sending and receiving notifications for
CNM users.

The Web Client URL value is used to add an object reference to a CNM object's Attachment
section. The URL is necessary to create a reverse link from the Agile PLM reference object
back to the CNM object.

The Search in Attachment value determines if the user can search the content of attachments
associated with objects. When the setting is No, searches are limited to include only
attachment names and descriptions.

The Viewer URL value is necessary to be able to render a view of an attachment for a UCM file
server configuration. If this value is set incorrectly or left blank, the user cannot view any
attachment content.

Note Without this value set, a user can still get attachments by saving them locally and
then opening them in the native application for the attachment.

The File Server Type value informs the administrator which file server type was configured at the
time of installation. The choices of Agile PLM File Server and UCM are available.

The File Folder Subclass value displays the file folder subclasses currently available and enabled
in Agile PLM. This dropdown list is dynamically produced each time you log in for a user
session.

Note If new subclasses are created and enabled in Agile PLM while in a current user
session, click Reset to refresh the CNM System Settings and the new file folder
subclasses are updated.

When the File Folder Subclass property is not defined, the file folder subclasses are deleted
or disabled in Agile PLM, then this property is empty and the action to add an attachment
in CNM is unavailable. It is recommended that that the file folder subclass selection you
choose for CNM object attachments be consistent to make it easier to find those file
folders and attachments in Agile PLM.

Note The File Folder Subclass property is uneditable for UCM configuration.
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The Online Help URL value gives a location for users to be directed to documentation. If you have
purchased a license for User Productivity Kit (UPK) content for CNM, this URL also directs
you to your UPK help topics.

The Agile PLM SSO Server URL value validates usernames and passwords for logging in to CNM
from Agile PLM when there is an SSO configuration for users.

Note If this value is left blank, CNM will automatically use the Agile PLM Server URL.
This server and URL are the recommended setting for this value.
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